CHAPTER

Other Network Management Tasks

Revised: December 16, 2009, OL-14480-06

This chapter provides information on the following:
e Performing Routine Network Management, page 8-1
e Using Cisco MNM to Launch Device Configuration, page 8-5
e Viewing or Modifying Account and SNMP Information, page 8-6
e Viewing Properties for Devices and Their Components, page 8-9
e Using Diagnostic Tools, page 8-57
e Using the MGC Toolbar, page 8-60

Performing Routine Network Management

This section presents checklists of routine procedures for network management using Cisco Media
Gateway Controller (MGC) Node Manager (MNM). Because Cisco MNM is used in many different
types of situations, no single checklist can describe optimal procedures for all cases. This information
is designed to guide you with your own management routines, tailored to your particular network and
users.

Note Cisco IP Transfer Point LinkExtender (ITP-L) is the new name for Cisco Signaling Link Terminal (SLT).
Over time, ITP-L will replace SLT in publications and the product.
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Procedures for Getting Started

Table 8-1 shows the procedures for getting started with network management.

Table 8-1 Procedures for Getting Started

Task

Location of Instructions

Install Cisco EMF and Cisco MNM (system
administrator only).

See the Cisco MNM Installation Guide.

Configure network devices for management
(system administrator only).

See Chapter 2, “Configuring Network Devices.”

Set up security (system administrator only).

See Chapter 4, “Setting Up Cisco MNM Security.”

Deploy the network, creating a model of your
network in Cisco MNM.

See Chapter 5, “Deploying Your Network in
Cisco MNM.”

Identify key performance measurements to
monitor.

See the “Selecting What to Monitor” section on
page 7-16.

Set up threshold crossing alerts and scoreboards.

See the “Task 2— Customizing Event
Management” section on page 6-4.

[l Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Routine Daily Procedures

Table 8-2 shows the routing daily procedures.

Table 8-2 Routing Daily Procedures

Performing Routine Network Management 1l

Task

Steps

(Ongoing) Monitor the network for changes in
status.

1. At the top level of the Map Viewer, monitor
changes.

2. When you see an alarm, drill down to find
where the problem occurred.

3. Right-click the device object and choose Tools
> Event Browser to view details on the alarm.

4. Click Acknowledge for this event to indicate
that the problem is being investigated.

See the “Using the Event Browser to Manage
Events” section on page 6-11 for details.

After identifying the alarm, use diagnostics to find
out the cause of the problem. See the “Using
Diagnostic Tools” section on page 8-57.

If the network is not monitored continuously, look
at alarms that came in overnight, specifically:

e Active alarms

e Alarms that were received and cleared,
including alarms cleared automatically

e Destination in service alarms, such as PRIs or
SS7s

e Switchovers from standby to active status

Work from the most severe alarm to the least
severe.

Investigate active alarms as described in the
previous task.

Alternatively, in the Map Viewer, right-click the
Cisco PGW 2200 Softswitch host object, choose
Properties, and click the Software tab. See the
“Viewing Properties for Devices” section on
page 8-10 for details.

Check the health of the devices assigned to you:
e Are they in service?
e Are they reachable by the ping command?

Is the device communicating with Cisco MNM?

If you cannot access a device, in the Map Viewer,
right-click the device object, and choose Tools >
[Device name] Diagnostics. On the General tab,
click IP Ping or SNMP Ping. See the “Using
Diagnostic Tools” section on page 8-57 for details.

Check the amount of disk space available on the
Cisco PGW 2200 Softswitch host. Pay special
attention to root (/) and opt directories.

Monitor the file system. In the Map Viewer,
right-click the Cisco PGW 2200 Softswitch host
object and choose File Systems. See the
“Monitoring the Cisco PGW 2200 Softswitch
Host, the Cisco HSI Server, and the Cisco BAMS
File Systems” section on page 8-20 for details.

Check the amount of virtual memory available on
the Cisco PGW 2200 Softswitch host.

In the Map Viewer, right-click the

Cisco PGW 2200 Softswitch host object and
choose Devices > Virtual Memory Properties.
See the “Viewing System Component Properties”
section on page 8-23 for details.

| oL-14480-06
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Table 8-2

Routing Daily Procedures (continued)

Task

Steps

Check the status of trunks.

Check status: In the Map Viewer, right-click the
Trunking folder, choose Properties, and click the
Status tab.

Check trunk group: In the Map Viewer, right-click
the BAMS, choose Properties, and click the
Status tab.

Check CPU usage on the
Cisco PGW 2200 Softswitch host.

In the Map Viewer, right-click the

Cisco PGW 2200 Softswitch host object and
choose Devices > Processor Properties. See the
“Viewing System Component Properties” section
on page 8-23 for details.

Check the number of processes running on the
Cisco PGW 2200 Softswitch host. Generally,
there should not be more than 60 to 70 processes
running.

To see the number of processes: In the Map
Viewer, right-click the

Cisco PGW 2200 Softswitch host object, choose
Properties, and click the Software tab. The
number of processes is displayed at the bottom of
the dialog box. See the “Viewing Properties for
Devices” section on page 8-10 for details.

To view the status of processes: In the Map Viewer,
right-click the device object and choose Tools >
MGC Host Diagnostics. On the General tab, click
Process Status. See the “Using Diagnostic Tools”
section on page 8-57 for details.

Check the number of users on the
Cisco PGW 2200 Softswitch host.

In the Map Viewer, right-click the

Cisco PGW 2200 Softswitch host object, choose
Properties, and click the Software tab. See the
“Viewing Properties for Devices” section on
page 8-10 for details.

Cisco ITP-Ls: Check memory used and RAM.

In the Map Viewer, right-click the Cisco ITP-L
object, choose Properties, and click the Memory
tab. See the “Viewing Properties for Devices”
section on page 8-10 for details.

For traffic engineering.

Look at trunk group measurements to identify
when the network is reaching circuit capacity.

(As needed) Deploy new devices and delete
obsolete devices.

See Chapter 5, “Deploying Your Network in
Cisco MNM.”

[l Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Using Cisco MNM to Launch Device Configuration

Routine Weekly Procedures

Table 8-3 shows the routine weekly procedures.

Table 8-3 Routing Weekly Procedures
Task For More Information, see
Analyze measurement data for trends: Chapter 7, “Managing the Performance of

Cisco MNM Devices,” “Exporting Bulk

1. Export desired performance data. " )
Performance Data” section on page 7-18

2. Import the data into an external measurement
report and analysis tool such as Trinogy
Trend.

Using Cisco MNM to Launch Device Configuration

From Cisco MNM, you can launch configuration tools for the Cisco PGW 2200 Softswitch node
devices. Specifically, you can launch

e The Cisco Voice Services Provisioning Tool (VSPT) to configure the Cisco PGW 2200 Softswitch
host.

~

Note  The Voice Services Provisioning Tool (VSPT) was formerly known as MNM-PT.

e CiscoView to configure the Cisco ITP-L and Cisco LAN switch.

e Telnet or an X terminal window to use MML, UNIX, and OSI commands. If SSH is enabled on
Cisco MNM and the target device, SSH is used instead.

Launching Configuration Tools

You can launch configuration tools for various devices from the Cisco MNM Map Viewer (see

Table 8-4).
Table 8-4 Configuration Tools for Cisco PGW 2200 Softswitch Node Devices
Cisco PGW 2200 Softswitch
Node Device Available Tools
Cisco PGW 2200 Softswitch |Cisco VSPT or Cisco MNM
host Telnet or ssh; MML
Cisco BAMS Telnet or ssh; MML
Cisco HSI server Telnet or ssh; MML
Cisco ITP-L CiscoView
Telnet or ssh
Cisco LAN Switch CiscoView
Telnet or ssh

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Step 1
Step 2

Step 3
Step 4

Step 1
Step 2

Step 3
Step 4

Use the following procedure to launch a configuration tool:

In the Map Viewer window, right-click the device you want to configure, and choose Tools.
From the Tools menu, choose one of the following:

¢ YVoice Services Provisioning Tool (or for Cisco PGW 2200 Softswitch Releases below 7.4(12),
Cisco MGC Manager) to configure the Cisco PGW 2200 Softswitch host

~

Note  The Voice Services Provisioning Tool option is only available when VSPT is installed.
To get more information on VSPT installation, see Chapter 2, “Installing Cisco VSPT” in the
Cisco Voice Services Provisioning Tool User Guide, Release 2.7(3) at
http://www.cisco.com/en/US/docs/net_mgmt/vspt/2.7/user/guide/install.html

¢ CiscoView to configure the Cisco ITP-L and Cisco LAN switch

The application opens.

>
Note  The Cisco PGW 2200 Softswitch deployment user ID and password are passed to Cisco VSPT
and you are logged in with the privileges assigned to that user: read-write or read-only. If there

is no deployment user ID or password, Cisco VSPT opens to the login window, and you must
log in manually.

Perform the desired actions.

Close the application when you are done.

Use the following procedure to launch a Telnet session (or ssh, if SSH is enabled) or an X terminal
window to use UNIX, OSI, and MML commands:

In the Map Viewer window, right-click the desired device, and choose Tools.

From the Tools menu, choose Connection Service.

A Telnet, ssh, or X terminal window opens, and you are connected to the selected device.
Perform desired actions.

Close the window when you are done.

Viewing or Modifying Account and SNMP Information

You can view the account and SNMP information that resides in the Cisco MNM database for any of the
following Cisco PGW 2200 Softswitch node devices:

e Cisco PGW 2200 Softswitch host
e (Cisco BAMS

e Cisco ITP-L

e Cisco LAN Switch

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

~

Note

Viewing or Modifying Account and SNMP Information

e Cisco HSI server

Account information and SNMP read and write community strings are defined when a device is
deployed. If the actual device information changes—for example, if a password is changed—you can
modify the information to update the Cisco MNM database. The changed information is used in device
rediscovery.

Use the following procedure to view or change account or SNMP information in the Cisco MNM
database:

In the Map Viewer window, select a device or devices.

~

Note  Alternatively, if you have a Properties, States, Diagnostics, or File Systems dialog box open for
the device, you can use the dialog box Navigation menu to open the Accounts dialog box.

Right-click the device or devices and choose Accounts.
The Accounts dialog box opens.

If you have selected more than one device, choose the desired device in the list box on the left side of
the dialog box.

Check or change device information. See the “Using the Accounts Dialog Box” section on page 8-7.

If you make changes, click the toolbar Save button, or choose File > Save. The updated information is
saved in the Cisco MNM database.

In the Accounts dialog box, you can use the toolbar buttons or menu options to
e Print the information on the current tab
¢ Close the dialog box
e Toggle dynamic update mode off and on
e Refresh the window to update the information when dynamic update mode is off
e Acknowledge that you have seen dynamically updated changes

You can use the Navigation menu to open the Properties, File Systems (where applicable), States, or
Diagnostics dialog box for the selected component.

e The status bar shows the current status of the device.

e If the account is locked (lock icon is closed), you do not have permission to view this information.

Using the Accounts Dialog Box

The Accounts dialog box displays login and SNMP information for the selected network device. This
information is used when the device is rediscovered. The Accounts dialog box contains the Accounts tab
and the SNMP tab.

By default, the Accounts dialog box is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes when dynamic updating is off.

| oL-14480-06
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The Accounts dialog box includes a Navigation menu that allows navigating directly to Properties, File
Systems, States, or Diagnostics dialog boxes for the selected component; you need not reselect the
component in the Map Viewer. See the “Navigating Between Dialog Boxes for a Given Component”
section on page 3-32 for details.

Accounts Dialog Box Toolbar

The Accounts dialog box toolbar buttons enable you to
e Close the current window
e Print the contents of the window
¢ Toggle dynamic update mode, to allow viewing or not viewing real-time changes
e Refresh the window, to update the information when dynamic update mode is off
e Acknowledge that you have seen dynamically updated dialog box changes
e Save your changes to the Cisco MNM database

Dynamic updates are displayed in blue. When an update occurs, the dialog box moves in front of other
open Cisco MNM windows. Click Acknowledge to acknowledge that you have seen the changes and to
remove the blue highlighting.

Accounts Tab
The Accounts tab contains the following fields:
e Login ID—The login ID defined in the Cisco MNM database
e Password—The password defined in the Cisco MNM database
¢ Root or Enable Password—The root or enable super-user password defined in the Cisco MNM
database
e Security Policy—The security protocol used for communication with the device, SSH or None
— Choose SSH if you have installed the Cisco EMF SSH add-in and the device is SSH-enabled.
With SSH support installed, all operations that previously used Telnet or FTP to communicate
with network elements instead use ssh (the secure shell program, the SSH counterpart of Telnet)
and sftp (secure FTP).
— Choose None for nonsecure devices.
SNMP Tab

The SNMP tab contains the following fields:
¢ Read Community—SNMP read-community string.
¢  Write Community—SNMP write-community string.

¢ Timeout (seconds)—The number of milliseconds the system attempts to connect remotely when
performing an SNMP operation before timing out. The default value is 5000.

e Retries—The number of times the system attempts to connect when performing an SNMP operation.
The default value is 2.

e Varbinds/Packet—The number of varbinds sent in a single packet to an SNMP agent. The default
value is 5.

e SNMP Version—The version of SNMP running on the device. Versions 1 and 2c are supported.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
8-8 0L-14480-06 |




| Chapter8

Other Network Management Tasks

Viewing Properties for Devices and Their Components [l

Viewing Properties for Devices and Their Components

Note

You can view properties for the following devices, including Cisco PGW 2200 Softswitch node devices
and their components. See the “Viewing Properties for Devices” section on page 8-10.

e Cisco PGW 2200 Softswitch host
e Cisco BAMS

e Cisco HSI server

e Cisco ITP-L

e Cisco LAN switch

You can view properties for serial, Ethernet, and TDM interfaces. See the “Viewing Properties for
Interfaces” section on page 8-15.

You can view properties and monitor the usage of the Cisco PGW 2200 Softswitch host, the Cisco HSI
server, and the Cisco BAMS file systems. See the “Monitoring the Cisco PGW 2200 Softswitch Host,
the Cisco HSI Server, and the Cisco BAMS File Systems” section on page 8-20.

You can view properties for system components (disk partitions, processor, RAM, and virtual memory)
of the Cisco PGW 2200 Softswitch host, the Cisco HSI server, and the Cisco BAMS. See the “Viewing
System Component Properties” section on page 8-23.

You can view properties for the following Cisco PGW 2200 Softswitch node components:
e Dial plan components. See the “Viewing Dial Plan Component Properties” section on page 8-25.
¢ Signaling components. See the “Viewing Signaling Component Properties” section on page 8-30.
¢ Trunking components. See the “Viewing Trunk Group Component Properties” section on page 8-47.

All Properties dialog boxes share the basic functionality described in the following section.

Dial Plan Components on Cisco PGW 2200 Softswitch are no longer supported since Cisco MNM
Release 2.7(3) Patch 4.

Common Functionality in Properties Dialog Boxes

Note

All Properties dialog boxes display dynamically updated information and provide functionality similar
to that available with the main functions accessible from a toolbar. If a Properties dialog box is opened
for more than one component, a list box on the left side of the dialog box lists the available components.
The Properties information applies to the selected component.

Properties dialog boxes include a menu where you can navigate directly to other dialog boxes for the
selected component without having to reselect the component in Map Viewer. See the “Navigating
Between Dialog Boxes for a Given Component” section on page 3-32.

The specific properties you see depends not only on the network element you are inspecting but also on
the release of the Cisco PGW 2200 Softswitch host software that you are using.

| oL-14480-06
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Properties Dialog Box Toolbar

In every Properties dialog box (see Figure 8-1), a toolbar contains buttons for these functions:
* Close the current window
e Print the contents of the window
¢ Toggle dynamic update mode, to allow viewing or not viewing real-time changes
e Refresh the window, to update the information when dynamic update mode is off
e Acknowledge that you have seen dynamically updated dialog box changes

In addition, because the File System dialog box includes settings that you can modify to change how the
file system is monitored, the File System Properties dialog box contains a Save button.

Dynamic updates are displayed in blue. When an update occurs, the dialog box moves in front of other
open Cisco MNM windows. Click Acknowledge to acknowledge that you have seen the changes and to
remove the blue highlighting.

Figure 8-1 Device Properties Dialog Box Toolbar

s E0 Y

Viewing Properties for Devices

Step 1
Step 2

Step 3

Step 4

You can view properties for any of the following Cisco PGW 2200 Softswitch node devices. Property
fields may vary.

e Cisco PGW 2200 Softswitch host
e Cisco HSI server

e Cisco BAMS

e Cisco ITP-L

e Cisco LAN switch

Use the following procedure to view properties for a device:

In the Map Viewer window, select a device or devices.
Right-click and choose Properties.
The Properties dialog box opens.

If you have selected more than one device, choose a device in the list box on the left side of the dialog
box.

Check device properties. See the “About the Device Properties Dialog Box™ section on page 8-11 for
details on properties.

(Optional) In the Properties dialog box, use the toolbar buttons or menu options to manipulate the
display.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Note The status bar shows the current status of the device.

About the Device Properties Dialog Box

The Properties dialog box contains a toolbar and tabs displaying various categories of device properties.
The contents of the tabs vary with the device type.

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, to acknowledge that you have seen updated information, and
to check for changes when dynamic updating is off. All fields are display-only.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more information.

General Tab

The General tab contains the following display-only fields:

Details Tab

Management Address—Network management IP address.

System Name—Administratively assigned name for the device.

Location—Physical location of the device.

Contact—Contact person or organization and brief contact information, such as phone number.

System Status (valid only for the Cisco BAMS, the Cisco HSI server, and the
Cisco PGW 2200 Softswitch)—Current operational status of the device. Values are Active, Standby,
Outage, Error, and Other.

Up-time—Time since the device was initialized.

Description—Description of the device.

The Details tab contains the following fields:

For the Cisco PGW 2200 Softswitch, the Cisco HSI Server, and the Cisco BAMS

Hardware Model—Hardware model for the device
OS Version—Version of the operating system

OS Release—Release level of the operating system
Host ID—Host ID

Memory Size—Amount of physical main memory
System Date—Local time and day on the host

Last Boot Time—Time the machine was last booted

For the Cisco ITP-L and Cisco LAN Switch

Model—Chassis type
Chassis ID—Unique identifier for the chassis (Cisco ITP-L) or serial number (Cisco LAN switch)

| oL-14480-06
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Note

For the Cisco ITP-L Only

e Hardware Version—Chassis hardware revision level
¢ ROM System Version—ROM system software version

e ROM Monitor Version—ROM monitor version

For the HSI Server Only
e Host Port-1—The first port number to be used by the Cisco HSI. The default value is 0.

e Host Port-2—The second port number to be used by the Cisco HSI. The default value is 0. This value
should not be changed; it should always be set to 0.

These values must match the peer port setting on the Cisco PGW 2200 Softswitch EISUP IPLNK object.

For the Cisco LAN Switch Only
e Fan Status—Status of the fan. Values are OK, Other, Minor Fault, and Major Fault.

Details Area

¢ System Type—Chassis system type
e Backplane Type—Chassis backplane type

Power Supply Area

e Status (Primary and Secondary)—Power supply status. Values are OK, Other, Major Fault, and
Minor Fault.

e Type (Primary and Secondary)—Type of power supply.

Host, HSI, or BAMS Tab (Cisco PGW 2200 Softswitch host, Cisco HSI server, or Cisco BAMS)

The MGC Host or BAMS tab contains the following fields:
e In the Call Agent, BAMS Software, or HSI Software area, information about the software:
— Host, BAMS version, or HSI version—Software version.
— Patch Level—Patch level of the software.
— (Cisco PGW 2200 Softswitch only) Host Vendor—Vendor of the host software.
— Home Directory—Software home directory.

— (Cisco PGW 2200 Softswitch only) Active Config Name—Name of the active MML
configuration, if any.

- (Cisco PGW 2200 Softswitch only) Desired State—Desired state of the platform, such as
standalone.

— (Cisco PGW 2200 Softswitch only) Switch Type—Switching configuration of the host.

— (Cisco PGW 2200 Softswitch only) Failover Peer Addresses A and B—IP address of each
failover machine.

— (Cisco HSI server only) Primary MGC—In the first row, under IP Address, the primary IP
address of the primary Cisco PGW 2200 Softswitch; under Port, the first port number of the
primary Cisco PGW 2200 Softswitch.

In the second row, the secondary IP address and the second port number of the primary
Cisco PGW 2200 Softswitch. These must match the primary information in the first row.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Note

Network Tab (All)

Viewing Properties for Devices and Their Components [l

— (Cisco HSI server only) Secondary MGC—In the first row, under IP Address, the primary IP
address of the secondary Cisco PGW 2200 Softswitch; under Port, the first port number of the
secondary Cisco PGW 2200 Softswitch.

In the second row, the secondary IP address and the second port number of the secondary
Cisco PGW 2200 Softswitch. These must match the information in the first row.

The Secondary MGC parameter is not used in a standalone Cisco PGW 2200 Softswitch configuration.

The Network tab contains the following fields:

e [P addresses configured on the device—IP addresses from the IP address table. A device can have
more than one IP address.

e [P Address—IP address of the selected entity.
e Net Mask—Subnet mask associated with the IP address.
e Interface Index—Interface on which the IP address is configured.
For the Cisco LAN switch, the Network tab contains these fields as well:
e Broadcast Address—The broadcast address of the switch.
e Net Mask—The net mask of the chassis.
¢ Booted Image—The name of the image from which the system was booted.

¢ Last Configuration Change—Time (in hundredths of a second) since the configuration of the system
was last changed.

The Cisco PGW 2200 Softswitch host also contains a Configuration area:
e [P addresses configured on the Call Agent—Cisco PGW 2200 Softswitch host network addresses

Software Tab (Cisco PGW 2200 Softswitch Host, Cisco HSI Server, and Cisco BAMS)

The Software tab contains the following fields, whose values describe software installed on the device:

e The software running on the selected device—A list of installed software. Select the software whose
details you want to view.

e Name—Name of the selected software.
e Parameters—Parameters supplied to the software when it was run.
e Path—Location where the software was run.
e Type—Type of software, such as operating system or device driver.
e Status—Status of the running software. Values are Running, Runnable, Not Runnable, and Invalid.
These fields apply to the Cisco PGW 2200 Softswitch host overall:
e Number of Processes
— Actual: Number of process contexts currently running.
— Maximum: Number of process contexts this system can support.
e Number of Users

— Actual: Number of user sessions for which this host is storing information.

| oL-14480-06
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— Maximum: Number of user sessions this host can support.

Virtual IP Tab (Cisco PGW 2200 Softswitch Host)

The Virtual IP tab contains the following fields:
e Pool Name—Name assigned to the selected memory pool, such as DRAM.
e Virtual IP address 1—Virtual IP address from Cisco PGW 2200 Softswitch host.
e Virtual IP Address 2—Second Virtual IP address from Cisco PGW 2200 Softswitch host.

Memory Tab (Cisco ITP-L and Cisco LAN Switch)

The Memory Tab contains the following fields:

e Memory Pool—A list of memory pools supported by the device. Select the memory pool whose
details you want to view.

¢ Pool Name—Name assigned to the selected memory pool, such as DRAM.
e Memory Used—Number of memory pool bytes that are currently in use by applications.
e Memory Free—Number of memory pool bytes that are unused.
e Largest Free—Largest number of contiguous bytes that are currently unused.
Cisco ITP-L only:

¢ Configuration Memory—Bytes of nonvolatile configuration memory In Use/Total bytes of
nonvolatile configuration memory.

e Processor RAM—Bytes of RAM available to the CPU.

Configuration Tab (Cisco ITP-L)

The Configuration Tab contains the following fields:

History Area

¢ Configuration events on the device—List of configuration events in the device history. Select a
device to view its details.

Event Time
¢ Source—Source of the selected configuration event

¢ Destination—Configuration data destination for the event
¢ Image Name—Name of the system boot image
e Reason for Last Reload—Reason the system was last restarted

¢ Running Last Changed—Value of system uptime (sysUpTime) when the running configuration last
changed

e Startup Last Changed—Value of system uptime when the startup configuration was last saved

e Running Last Saved—Value of system uptime when the running configuration was last saved

Poll Tab (BAMS)

The Poll tab contains the following fields:

e Poll information—Poll table.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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e Host Name (primary and secondary)—MGC host for this BAMS.

e Prefix (primary and secondary)—Prefix for data files on the host.

e Suffix (primary and secondary)—Suffix for data files on the host.

e Remote Directory (primary and secondary)—Remote directory on the host.
e Action—Action to perform after polling.

¢ Interval—Polling unit (in minutes). Default value is 10.

¢ Timeout—Timeout for file transfer. Default value is 10.

e Maxtries—Maximum number of retries on each file. Default value is 3.

RAS Parameters Tab (HSI Server)

The RAS Parameters Tab contains the following fields:
¢ Gatekeeper ID—Identifying name of the gatekeeper with which the endpoint is trying to register.

e Gateway Prefix—The telephone prefix for which the gateway is registering as being able to
terminate.

¢ RAS Port—Number of the port receiving all RAS transactions for the current endpoint. Set to 0 to
allow the OS to look for the available port.

e Gatekeeper IP Address—The IP address of a known gatekeeper with which an endpoint attempts to
register.

e Gatekeeper Port—The port associated with the Gatekeeper IP Address, which can be either a
well-known port or another port by agreement.

Viewing Properties for Interfaces

Step 1

Step 2

Step 3

Step 4

You can view properties for serial, Ethernet, loopback, and TDM interfaces of the various MGC node
devices. You can view properties for ports, VLAN, and SCO/SLO interfaces of the Cisco LAN switch.

Use the following procedure to view property information for interfaces:

In the Map Viewer window, select the desired interface.

~

ma Find TDM interfaces under the Cisco ITP-L.

Right-click and choose Properties.
The Properties dialog box opens.

If you have selected more than one device, choose a device in the list box on the left side of the dialog
box and check device properties.

See the “About the Serial, Ethernet, Loopback, and SCO/SLO Interface Properties Dialog Box™ section
on page 8-16 and the “About the TDM Interface Properties Dialog Box” section on page 8-16 for details
on interface properties.

(Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to
¢ Print the information on the current tab.

¢ Close the dialog box.

| oL-14480-06
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¢ Toggle dynamic update mode off and on.
e Refresh the window to update the information when dynamic update mode is off.
e Acknowledge that you have seen dynamically updated changes.

~

Note  The status bar shows the current status of the interface.

About the Serial, Ethernet, Loopback, and SCO/SLO Interface Properties Dialog Box

General Tab

Details Tab

The Serial, Ethernet, Loopback, and SCO/SLO Interface Properties dialog boxes contain a toolbar and
General and Details tabs. All fields are display-only.

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more on dialog box
functionality.

The General tab contains the following display-only fields:

¢ Physical Address (Ethernet, Loopback, and SCO/SLO only)—The interface address at the protocol
sublayer.

e Description—A description of the interface.

e System Name—The administratively assigned name for the interface.

e Interface Type—The type of interface, such as FDDI.

e Admin Status—The desired state of the interface. The value can be Up, Down, or Testing.

e Operational Status—The current operational state of the interface. Values are Up, Down, Testing,
Unknown, Dormant, Not Present, and Lower Layer Down.

The Details tab contains the following fields:
e Interface Index—Index of this interface in the interface table (ifTable)
e MTU—Size of the largest packet that can be sent or received on the interface
e Speed (Ethernet, Serial, SCO/SLO only)—Estimated speed of the interface, in bits per second

e Last Change—Time at which an interface was last created or deleted

About the TDM Interface Properties Dialog Box

The TDM Interface Properties dialog box contains a toolbar and General and Details tabs. All fields are
display-only.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more on dialog box

functionality.
General Tab
The General tab contains the following display-only fields:
e Description—A description of the interface
e System Name—The administratively assigned name for the interface
¢ Circuit ID—Transmission vendor’s circuit identifier
e Speed—Estimated speed of the interface, in bits per second
¢ Interface Index—Index of this interface in the interface table (ifTable)
e Interface Type—The type of interface, such as FDDI
e Line Type—DSI line type
¢ Line Coding—Variety of Zero Coding Suppression used on the link
e Last Change—Time at the last creation or deletion of an interface
Details Tab

The Details tab contains the following fields:

Status Area

¢ Admin Status—The desired state of the interface. Values are Up, Down, and Testing.

e Operational Status—The current operational state of the interface. Values are Up, Down, Testing,
Unknown, Dormant, Not Present, and Lower Layer Down.

e Line Status—Alarm status of the line.

Configuration Area
e Signal Mode—Signaling mode. Values are None, Robbed bit, Bit oriented, and Message oriented.

e Send Code—Type of code sent across the interface. Values are No code, Line code, Payload code,
and Reset code.

e Facilities Data Link—Use of the facilities data link.

¢ Loopback Config—Loopback configuration of the interface. Values are No loop, Payload loop, line
loop, and other loop.

e Transmit Clock Source—Source of the transmit clock. Values are Loop timing, local timing, and
through timing.

About the Cisco LAN Switch Port Properties Dialog Box

The Port Properties dialog box contains a toolbar and General, Details, and VLAN tabs. All fields are
display-only.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more on dialog box
functionality.

General Tab

The General tab contains the following display-only fields:

Details Tab

Physical Address—The interface address at the protocol sublayer.

Description—A description of the interface.

System Name—The administratively assigned name for the interface.

Interface Type—The type of interface, such as FDDI.

Admin Status—The desired state of the interface. Values are Up, Down, and Testing.

Operational Status—The current operational state of the interface. Values are Up, Down, Testing,
Unknown, Dormant, Not Present, and Lower Layer Down.

MTU—Size of the largest packet that can be sent or received on the interface.

Last Change—Time at the last creation or deletion of an interface.

The Details tab contains the following fields:

VLAN Tab

Port Name—Name of the port.
Port Type—Type of physical layer medium dependent interface on the port.

Port Status—Current operational status of the port. Values are Up, Down, Testing, Unknown,
Dormant, Not Present, and Lower Layer Down.

Duplex—Indicates whether a port is operating in half-duplex, full-duplex, disagree, or
auto-negotiation mode.

Span Tree Fast Start—Whether the port is operating in span tree fast mode. Values are Enabled and
Disabled.

Desired Speed—Desired speed of the port, in bits per second.

Speed—Estimated speed of the interface, in bits per second.

The VLAN tab contains the following fields:

VLAN Number—Number assigned to the port.

Switching Priority—Priority level the port uses to access the switching media. Values are Normal,
High, and Not Applicable.

Admin Status—Indicates whether the port will be assigned to a VLAN statically or dynamically.
Values are Static and Dynamic.

Operational Status—Current VLAN status of the port. Values are Inactive, Active, Shutdown, and
VLAN Active Fault.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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About the Cisco LAN Switch VLAN Properties Dialog Box

The VLAN Properties dialog box contains a toolbar and the fields described below. All fields are
display-only.

By default, the Properties dialog box is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more on dialog box
functionality.

Fields

¢ System Name—The administratively assigned name for the interface

e Spanning Tree Enabled—Whether Spanning Tree Protocol is enabled for this VLAN

Viewing Properties for the Cisco ITP-L SS7 MTP2 Channel

Step 1
Step 2

Step 3

Step 4

Step 5

~

Note

Use the following procedure to view information on properties for the MTP2 channel:

In the Map Viewer widow, select the Cisco ITP-L.
Right-click and choose Channels > MTP2 Channel Properties.
The SS7 MTP2 Properties dialog box opens.

If you have selected more than one device, choose a device in the list box on the left side of the dialog
box.

Check device properties. See the “About the Serial, Ethernet, Loopback, and SCO/SLO Interface
Properties Dialog Box” section on page 8-16 or the “About the TDM Interface Properties Dialog Box”
section on page 8-16 for details on interface properties.

(Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to
e Print the information on the current tab.
¢ Close the dialog box.
e Toggle dynamic update mode off and on.
e Refresh the window to update the information when dynamic update mode is off.

e Acknowledge that you have seen dynamically-updated changes.

The status bar shows the current status of the channel.

About the SS7 MTP2 Channel Properties Dialog Box

The Cisco ITP-L SS7 MTP2 Channel Properties dialog box contains a toolbar and the fields described
below. All fields are display-only.

| oL-14480-06
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By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more information
on dialog box functionality.

The SS7 MTP2 Channel Properties dialog box contains the following fields:
¢ Channel Number—MTP2 channel number
e Link Status—Overall status of the link
e Alignment Error Rate Monitor—Status of the alignment error rate monitor state machine
e Signal Unit Error Monitor—Status of the signal unit error monitor (SUERM)
e Transmission Control—Status of the initial alignment control state machine
e Receive Control—Status of the receive control state machine
e Remote Processor Outage—Processor outage status of the remote processor

¢ Congestion Backhaul—Congestion control state between the Cisco PGW 2200 Softswitch host and
the Cisco ITP-L

¢ Congestion—Status of the congestion control state machine

Monitoring the Cisco PGW 2200 Softswitch Host, the Cisco HSI Server, and the
Cisco BAMS File Systems

Step 1

You can monitor file systems on the Cisco PGW 2200 Softswitch host, the Cisco HSI server, and the
Cisco BAMS by doing any of the following:

e Viewing file system information
e Setting a threshold to have the device send a trap if file system usage passes the threshold
e Viewing which file systems have exceeded their threshold

¢ Polling file systems at a desired frequency. (You set the frequency, either a global polling frequency
or an individual frequency, before the polling begins.)

e Polling all file systems
e Turning traps on or off for individual file systems based on trap severity

Use the following procedure to monitor the Cisco PGW 2200 Softswitch host, the Cisco HSI server, and
the Cisco BAMS file systems:

In the Map Viewer window, right-click a Cisco PGW 2200 Softswitch host, a Cisco HSI server, or a
Cisco BAMS, and choose File Systems.

The File System Properties dialog box opens, displaying file system properties and settings for
monitoring the file system.

If there is more than one selected device, the details shown apply to the currently highlighted device. In
the list, click the device whose details you want to view or change. See the “About the File System
Properties Dialog Box” section on page 8-21 for details.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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~

Note  Alternatively, if you have an Accounts, Properties, States, or Diagnostics dialog box open for the
device, you can use the dialog box Navigation menu to open the File Systems dialog box.

Check or change settings as needed:
e Use the General tab to view file system information.
e Use the Monitor tab to change settings for monitoring file system usage.
¢ Use the Exception tab to check file systems that have crossed their threshold.

If you make changes, click the toolbar Save button.

About the File System Properties Dialog Box

The File System Properties dialog box contains a toolbar and three tabs (General, Monitoring, and
Exceptions).

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more on dialog box
functionality. Unlike other Properties dialog boxes, the File System Properties dialog box includes a
toolbar Save button for saving changes to monitoring specifications.

General Tab
The General tab contains the following display-only fields:
e File System—List of file systems for this device. Select a system to view details.
e (Capacity—Percentage of normally available space that is currently allocated to files on the system.
e Used Space—Amount of space allocated to existing files.
e Free Space—Total amount of space available for the creation of new files by unprivileged users.
¢ Mount Point—Mount point (directory) of the file system.
Monitor Tab
The Monitor tab contains the following fields:
¢ File System—List of file systems. Select a system to check or change monitoring settings.
e Current Utilization—Percent of disk space currently In Use or the Percent full at which an event
(alarm) is triggered for the selected file system. Set alarm severity with Trap Severity.
e Poll Interval—Period of time, in seconds, between two successive checks of the file system, to see
if it exceeds its threshold.
e Threshold Command—Command to execute when the threshold is exceeded.
e Trap Severity—Severity of the trap that is sent when the threshold is exceeded. Values are Warning
and Critical.
e When Above Threshold—Send a trap if the threshold is exceeded. Values are Send Trap and Don’t
Send Trap. Use Don’t Send Trap to turn off notification for the selected file system.
Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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e  When Below Threshold—Send a trap if file system usage falls below the threshold. Values are Send
Trap and Don’t Send Trap. Use Don’t Send Trap to turn off notification for the selected file system.

¢ Global Poll Interval—Period of time, in seconds, between two successive checks of all file systems,
to see if any exceed the threshold.

¢ Poll Now button—Check all file systems for this device immediately.
)

Note  The Poll Now function is not currently supported for an individual file system. Global Poll Now (all file
systems) is supported.

Exceptions Tab

¢ File system list box—List of file systems that have exceeded their threshold. Select a file system to
view details.

¢ File System—Name of the selected file system.
e Threshold—Threshold that has been exceeded.

e Current Utilization—Current percent utilization of the file system.

Viewing BAMS Node Properties

Use the following procedure to view BAMS Node properties:

Step 1 In the Map Viewer window, select the desired BAMS node.
Step2  Right-click and choose Properties.
The BAMS Node Properties dialog box opens.
Step3  (Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to:
e Print the information on the current tab.
¢ Close the dialog box.
e Toggle dynamic update mode off and on.
e Refresh the window to update the information when dynamic update mode is off.
e Acknowledge that you have seen dynamically updated changes.

~

Note  The status bar shows the current status of the interface.

About the BAMS Node Properties Dialog Box

The BAMS Node Properties dialog box contains a toolbar and tabs displaying various categories of
component properties. All fields are display-only.

By default, the Properties dialog box is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off, acknowledge that you have seen updated information, and
check for changes as desired when dynamic updating is off.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Properties Tab
The Properties tab contains the following display-only fields:
¢ Node Name—The name of the node.
¢ Node Status—Current Operational state of the node. Values are Active, Standby, Outage, Error, and
Other.

e Measurement Interval—Interval in minute to generate measurement data.

¢ SC Collection—Indication flag of nail configuration collection.

e Dynamic Accumulator—Indication flag of dynamic accumulator usage.

e Zero-Count Suppression—Indication flag of the zero-count suppression feature.

¢ BAF ASCII Output—Indication flag of BAF records output in ASCII format.

¢ BAF Output—Indication flag of BAF records output.

e BAF Error Output—Indication flag of printing BAF error to syslog.

e ASCII Output—Indication flag of ASCII output.

e Measurement Output—Indication flag of measurement output function.

e Lookup Error Output—Indication which lookup errors are printed to syslog.
Poll Tab

The Poll tab contains the following fields:
¢ Poll information—Poll table.

¢ MGC Host (primary and secondary)—Cisco PGW 2200 Softswitch hosts that this BAMS node polls
for CDR records.

e Prefix (primary and secondary)—Prefix for CDR data files on the Cisco PGW 2200 Softswitch host.
e Suffix (primary and secondary)—Suffix for CDR data files on the Cisco PGW 2200 Softswitch host.

e CDR Directory (primary and secondary)—Directory of the CDR data files on the
Cisco PGW 2200 Softswitch host.

¢ Interval—Polling unit (in minutes). Default value is 10.
¢ Timeout—Timeout for file transfer. Default value is 10.

e Max Attempt—Maximum number of retries on each file. Default value is 3.

Viewing System Component Properties

You can check properties on the following system components of a Cisco PGW 2200 Softswitch host, a
Cisco HSI server, or a Cisco BAMS:

e Disk partitions
e Processor
e RAM

e Virtual memory

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Note

Step 1

Step 2

For information about viewing performance data for system components, see the “Performance Data
Collected for System Components” section on page B-11.

Use the following procedure to view system component properties:

In the Map Viewer window, do one of the following:

e To view information for all components of a particular type, right-click a
Cisco PGW 2200 Softswitch host, Cisco HSI server, or Cisco BAMS. Choose Devices, and then
choose one of the following:

— Disk Partition Properties

— Processor Properties

— RAM Properties

— Virtual Memory Properties

e To view information for a particular component, under the Cisco PGW 2200 Softswitch host,
Cisco HSI server, or Cisco BAMS, select the component and right-click. Choose Properties.

The dialog box displays information on the selected component’s properties. See the “About the
System Components Properties Dialog Boxes” section on page 8-24 for details.

(Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to
e Print the information on the current tab
¢ Close the dialog box
e Toggle dynamic update mode off and on
e Refresh the window to update the information when dynamic update mode is off

e Acknowledge that you have seen dynamically updated changes

About the System Components Properties Dialog Boxes

There are two types of system component Properties dialog boxes for the Cisco PGW 2200 Softswitch
host, Cisco HSI server, and Cisco BAMS:

e A Properties dialog box for fixed disk, RAM, and virtual memory
e A Properties dialog box for the processor

By default, the Properties dialog is dynamically updated as device information changes. You can use
toolbar buttons to turn updating on or off and check for changes when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more on dialog box
functionality.

Fixed Disk, RAM, and Virtual Memory Properties Dialog Box

The Disk, RAM, and Virtual Memory Properties dialog boxes contain the following fields:
e Description—Description of the type and instance of the selected storage device.

e Allocation Units—Size in bytes of the data object allocated from this pool.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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e Space Used—Amount of the storage that is allocated.
e Total Size—Size of the total device storage.

e Allocation Failures—Number of requests for storage that could not be honored.

Processor Properties Dialog Box

The Processor Properties dialog box contains the following fields:
e Description—Description of the processor.
e Status—Current operating status. Values are Running, Unknown, Testing, Warning, and Down.
e Utilization—Average amount of time that the processor was active over the last minute.

e Errors—Number of errors detected on this device.

Viewing Dial Plan Component Properties

You can view the properties of the following dial plan components of a Cisco PGW 2200 Softswitch
node:

e A- and B-digit trees

* Routes

e Routing

e Dial plan properties
)

Note  Dial Plan Components on Cisco PGW 2200 Softswitch are no longer supported since Cisco MNM
Release 2.7(3) Patch 4.

In addition, you can set and view these relationships between dial plan components:

e The relationship between conditional route and day of the week. A single conditional route can be
associated with one or more conditional route descriptors on a given day, or it can be related to the
same descriptor on multiple days. This appears in the Map Viewer as the Conditional Route Day,
with the day of the week and the conditional route name appended to it.

e The relationship between conditional route descriptor and the route list or percentage route. A single
conditional route descriptor can be associated with one or more conditional route lists or percentage
routes. This appears in the Map Viewer as the Conditional Route Descriptor Details, which has the
route list or percentage route with the conditional route descriptor name appended to it.

e The relationship between the percentage route and the route list or conditional route. A single
percentage route can be associated with one or more conditional routes or route lists. This appears
in the Map Viewer as the Percentage Route Descriptor, which has the route list or conditional route
with the percentage route name appended to it.

Use the following procedure to view dial plan component properties:

Step 1 In the Map Viewer window, do one of the following:

e To view information for all components of a particular type, select the dial plan folder and
right-click. Choose one of the following:

— Digit Trees, and then one of the following:

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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A-Digit Tree Properties

B-Digit Tree Properties

Routes, and then one of the following:
Route Trunk Properties

Route List Properties

Route Trunk Group Properties

Bearer Cap(ability) Properties
Routing, and then one of the following:

Percentage Routes > Percentage Route or Relationship between Percentage Route and
RouteList/Conditional Route

Conditional Routes > Conditional Route, Relationship between Conditional Route and Day of
Week, Conditional Route Descriptor, Conditional Route Descriptor Details, or Relationship
between Conditional Route Descriptor and RouteList/Percentage Route

Route Holiday Properties
Result Table Properties
Result Set Properties
CPC Properties

Codec String Properties
TMR Properties

TNS Properties

Dial Plan Properties

To view information for a particular component, under the dial plan folder, select the desired
component and right-click. Choose Properties.

The dialog box displays information on the selected component’s properties. See the “About the Dial
Plan Properties Dialog Boxes” section on page 8-26 for details.

Step2  (Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to:

Print the information on the current tab.

Close the dialog box.

Toggle dynamic update mode off and on.

Refresh the window to update the information when dynamic update mode is off.

Acknowledge that you have seen dynamically-updated changes.

About the Dial Plan Properties Dialog Boxes

The various Properties dialog boxes for dial plan components contain a toolbar and the fields described
in Table 8-5. By default, the Properties dialog is dynamically updated as device information changes.
You can use toolbar buttons to turn updating on or off, acknowledge that you have seen updated
information, and check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more information
on dialog box functionality.
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Properties of Dial Plan Components

Field Name

Description

A- or B-Digit Tree Properties dialog box

Customer Group ID

ID of the customer associated with the selected trunk group.

Digit String

All the digits in a calling or called number.

Digit-to-Present

Number of digits to skip (backward or forward) during analysis.
Enter - to skip backwards.

Set Name

Name of the result set for the selected component.

Call side

Side of the call. Values are Originating and Terminating.

Route Trunk Properties dialog box

MML Name Name of the component.

Trunk Group Name of the trunk group.

Next Trunk Group Trunk group number of the next trunk group, if any.

Weighted Trunk Set to on if weighted trunk group routing is desired. Values are On

or Off.

Route List Properties dialog box

MML Name

Name of the component.

Route Name

Name of the route.

Carrier ID

Carrier ID with which users on this trunk group are associated.

Distribution

Sequential distribution. Values are On (trunk groups in a route are
selected sequentially) and Off (trunk groups in a route are selected
randomly).

Route Trunk Group Properties dialog box

MML Name

Name of the component.

Trunk Type

The trunk transmission media.

Cut-through

The point in the calling process where the trunk is seized from end
point to end point.

Queuing

Duration in seconds the call is queued.

Reattempts

The number of times the system attempts to select a trunk group.

Reserve Circuits %

Reserve circuits percentage.

Bearer Capability Name

Bearer capability name (the MML name in the Bearer Capability
Properties dialog box).

SIP Route Trunk Group Properties

Bearer Capability Name

Bearer capability name (the MML name in the Bearer Capability
Properties dialog box).

Bearer Capability Properties (in the Map Viewer, appears under route trunk, route trunk group)

MML Name

Name of the component, such as bearerl.

Bearer Capability

Series of transmission medium requirements (TMR) values (see
TMR Properties), separated by semicolons, such as 12;05;21.

Percentage Route Properties dialog box

| oL-14480-06
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Table 8-5 Properties of Dial Plan Components (continued)
Field Name Description
MML Name Name of the component.

Relationship between Percentage Route and RouteList/Conditional Route

Percentage Route Name

Percentage route name.

Name

Over Flow Supported

Overflow supported.

Over Flow

This entry is the overflow entry [y/n].

Primary

This entry is the primary entry [y/n].

Route List Name

Route list name.

Conditional Route Name

Conditional route name.

Conditional Route Properties

MML Name

Name of the component.

Day of Week

Day of the week.

Relationship between Conditional Route and Day of Week

Conditional Route Name

Name of the conditional route.

Day of Week

Day of the week to associate with this conditional route, either a
default or a day between Sunday and Saturday, or one of the days
defined as a holiday in Route Holiday Properties.

Conditional Route
Descriptor

Conditional route descriptor name.

Conditional Route Descriptor Properties

MML Name

MML name.

Relationship between Conditional Route Descriptor and RouteList/Percentage Route

Conditional Route

Conditional route descriptor name.

Descriptor
Start Time Time to start, in the form hhmm, 24 hour day.
End Time Time to end.

Route List Name

Route list name.

Percentage Route Name

Percentage based route name.

Primary

The primary entry for percentage-based routing.

Route Holiday Properties

A

Note In the Map Viewer, the Route Holiday component appears under the dial plan object and is
named for the date, such as 2003.12.25.

Customer Group ID

ID of customer associated with the selected trunk group.

Holiday Day

Holiday day.

Date of Holiday

Date of the holiday, in the form YYYY.MM.DD.

Result Set Properties dialog box

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Table 8-5 Properties of Dial Plan Components (continued)
Field Name Description
MML Name Name of the component.

Customer Group ID

ID of customer associated with the selected trunk group.

Result Table Properties dialog box

MML Name

Name of the component.

Customer Group ID

ID of customer associated with the selected trunk group.

Set Name

Name of the result set.

Result type

Type of result set.

Data word 1 to Data word 4

Data words 1 through 4.

CPC (Calling Party Category) Properties. These properties detect and effect routing based on CPC.

~

Note In the Map Viewer, the CPC component appears under the result set object, below the result
table, with a name in the form cpc-CPC value, such as “cpc-15”.

Customer Group ID

ID of customer associated with the selected trunk group.

CPC Value

Calling party category value.

Set Name

Name of the result set.

Codec String Properties (in the Map Viewer, appears under result set, result table).

MML Name

Name of the component, such as codecl.

Codec String

Set of codec choices separated by semicolons, such as
G.726-32;G.729b-L.

TMR (Transmission Medium Requirements) Properties

S

Note  Inthe Map Viewer, the TMR component appears under the result set object with a name in the
form tmr-TMR value, such as “tmr-1".

Customer Group ID

ID of customer associated with the selected trunk group.

TMR Value

Transmission medium requirements value.

Set Name

Name of the result set.

TNS (Transit Network Selection) Properties

S

Note  Inthe Map Viewer, the TNS component appears under the result set object with a name in the
form tns-TNS value, such as “tns-333”.

Customer Group ID

ID of customer associated with the selected trunk group.

TNS Value

Transit network selection value.

Set Name

Name of the result set.

Dial Plan Properties

Customer Group ID

ID of customer associated with the selected trunk group.

Over-Decadic Status

Over-decadic status. Value: YES or NO.
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Viewing Signaling Component Properties

You can view properties of the following signaling components of a Cisco PGW 2200 Softswitch node:
e Paths
e Links
e Point codes
e External nodes
¢ Interfaces
e SS7 components
e M3UA/SUA components
e [Ps In Mapping (Added in Release 2.7(3) Patch 3, used only for EISUP and SIP signaling services)

Use the following procedure to view signaling component properties:

Step1  In the Map Viewer window, do one of the following:

¢ To view information for a particular component, under the Signaling folder, right-click the desired
component and choose Properties.

The dialog box displays information on the selected component’s properties. See the “About the
Signaling Components Properties Dialog Boxes” section on page 8-31 for details.

¢ To view information for all components of a particular type, right-click the Signaling folder and
choose one of the following:

- Paths, and then choose the desired type of path component. See Table 8-6 for dialog box details.
— Links, and then choose the desired type of link component. See Table 8-7 for dialog box details.

— Point Codes, and then choose the desired type of point code component. See Table 8-8 for
dialog box details.

)

Note In Cisco PGW 2200 Softswitch Release 9.x, detailed DPC point code properties do not appear
on the Details tab of the DPC Properties dialog box. Instead, drill down from the DPC to the SS7
path object (ss7svcl, for example), choose Properties, and in the Properties dialog box click the
Details tab.

— External Nodes, and then choose the desired type of external node component. See Table 8-9
for dialog box details.

— Interfaces, and then choose the desired type of interface component. See Table 8-10 for dialog
box details.

— SS7 Components, and then choose the desired type of SS7 component. See Table 8-11 for
dialog box details.

- MB3UA/SUA Components, and then choose either the M3UA Key or Route component, or SUA
Key or Route component. See Table 8-12 for details.

— IPs In Mapping Components, and then choose the desired type of mapping. See Table 8-13
for dialog box details. (Added in Release 2.7(3) Patch 3)

Step2  (Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to

e Print the information on the current tab

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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¢ Close the dialog box
e Toggle dynamic update mode off and on
e Refresh the window to update the information when dynamic update mode is off

e Acknowledge that you have seen dynamically updated changes

About the Signaling Components Properties Dialog Boxes

The various Properties dialog boxes for signaling components contain a toolbar and fields described in
tables below for each component type. By default, the Properties dialog box is dynamically updated as
device information changes. You can use toolbar buttons to turn updating on or off, acknowledge that

you have seen updated information, and check for changes when dynamic updating is off.

Signaling path components, in Table §-6

Signaling link components, in Table 8-7

Signaling point code components, in Table §8-8

Signaling external node components, in Table §8-9

Signaling interface components, in Table 8-10

Signaling SS7 components, in Table 8-11
Signaling M3UA/SUA components, in Table 8-12
IPs In Mapping components, in Table 8-13 (Added in Release 2.7(3) Patch 3)

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more on dialog box

functionality.
Table 8-6 Properties of Signaling Path Components
Property Description

Association Properties Dialog Box

General Tab

MML Name Name of the component.

Description Description of the MML componen.t
Port Local SCTP port number.

Peer Port Destination SCTP port number.

External Node

Name of a previously configured external node.

First IP Address

First local address.

Second IP Address

Second local address.

First Peer Address

The highest priority destination address.

Second Peer Address

The lowest priority destination address.

Receive Window Bytes

Number of bytes to advertise for the local receive window.

IP Route 1

MML name of the first IP route.

IP Route 2

MML name of the second IP route.
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Table 8-6 Properties of Signaling Path Components (continued)

Property Description

Time Between Heartbeats |Time between heartbeats. The heartbeat is this value plus the current
retransmission timeout value.

Max Retransmissions Maximum number of retransmissions to either the first or second peer
address before the association is declared failed.

Previously Configured MML name of a previously configured SGP.
SGP

Details Tab

Maximum Init Maximum initial retransmission timer value.
Retransmission Timer

Max Retransmission Maximum value allowed for the retransmission timer.

Timer

Min Retransmission Minimum value allowed for the retransmission timer.

Timer

Maximum Maximum number of retransmissions over all destination addresses

Retransmissions to Dest  |before the association is declared failed.

Max Bundling Wait Time |Maximum time SCTP waits for other outgoing datagrams for
bundling.

Max Init Retransmission |Maximum number of times to retransmit SCTP INIT message.
Times

Max Time Before Sending |Maximum time after a datagram is received before an SCTP SACK is
SACK sent.

Association State State of SCTP association.

AXL Server Properties Dialog Box

MML Name Name of the component.

Description Description of the MML component.

First IP Address First local address.

Second IP Address Second local address.

Port Local SCTP port number.

First Peer Address The highest priority destination address.

Peer Port Destination SCTP port number.

IP Route 1 MML name of the first IP route.

IP Route 2 MML name of the second IP route.

CTI Path CTI Sig Path component.

Version The version of CTI Path supported by Cisco PGW 2200 Softswitch.
BRI Path Properties Dialog Box

MML Name Name of the component.

Description Description of the MML component.

External Node MML Name of a previously configured external node.

Side User for user side and network for network side; (network).

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Table 8-6 Properties of Signaling Path Components (continued)
Property Description
MDO Message definition object file protocol name.

Customer Group ID

Four-digit ID; (0000).

Call Ref Length

1 for 1-byte or 2 for 2-byte call reference length; (0).

Admin State

Administrative state of the component.

Destination Association

Destination Association.

Destination State

Destination State.

Destination Package

Destination Package.

Locked

Number of bearer channels in LOCKED state.

Unlocked

Number of bearer channels in UNLOCKED state.

Shutdown

Number of bearer channels in SHUTDOWN state.

CAS Path Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

External Node

External node.

Customer Group ID

ID of the customer group associated with the selected trunk group.

Side

Q.931 call model side.

Admin State

Administrative state of the component.

Locked Number of bearer channels in LOCKED state.
Unlocked Number of bearer channels in UNLOCKED state.
Shutdown Number of bearer channels in SHUTDOWN state.

CTI Path Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

External Node

MML name of a previously configured external node for this CTI
path.

CTI Manager Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

First IP Address

First local address.

Second IP Address

Second local address.

Port Local SCTP port number.

First Peer Address The highest priority destination address.

Peer Port Destination SCTP port number.

IP Route 1 MML name of the first IP route.

IP Route 2 MML name of the second IP route.

CTI Path CTI Sig Path component configured for this CTI Manager.
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Table 8-6 Properties of Signaling Path Components (continued)
Property Description
Version The version of CTI Manager supported by
Cisco PGW 2200 Softswitch.
DPNSS Path Properties Dialog Box
General Tab
MML Name Name of the component.
Description Description of the MML component.
Destination Association |Type of association.
Component Type Type of component.
External Node External node.
Customer VPN ID VPN customer name assigned to the selected trunk group.
Customer Group ID ID of the customer group associated with the selected trunk group.
Signal Slot Physical slot on Cisco 2600/3660 router (optional).
Signal Port Physical port on the slot of Cisco 2600/3660 router (optional).
Destination Package Name of the installed package.
A/B Flag DPNSS side.
Details Tab
Admin State Administrative state of the component.
Destination State Destination state.
Locked Number of bearer channels in LOCKED state.
Unlocked Number of bearer channels in UNLOCKED state.
Shutdown Number of bearer channels in SHUTDOWN state.
EISUP Path Properties Dialog Box
MML Name Name of the component.
Description Description of the MML component.
External Node External node
Customer Group ID ID of the customer associated with the selected trunk group.
Customer Group Table Customer group table.
Side Q.931 call model side.
Admin State Administrative state of the component. (Removed in Release 2.7(3)
Patch 3)
Destination State Point-code state
Locked Number of bearer channels in LOCKED state. (Removed in Release
2.7(3) Patch 3)
Unlocked Number of bearer channels in UNLOCKED state. (Removed in
Release 2.7(3) Patch 3)
Shutdown Number of bearer channels in SHUTDOWN state. (Removed in
Release 2.7(3) Patch 3)

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Table 8-6 Properties of Signaling Path Components (continued)
Property Description

Orig Label Origination Location Label

Term Label Termination Location Label

FAS Path Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

Customer Group Table

Customer group table.

Customer Group ID

ID of the customer associated with the selected trunk group.

Call Ref Length

Call reference length.

Side Q.931 call model side.
MDO Message definition object file protocol name.
A/B Flag Specifies DPNSS a or b side.
ASP Part Auxiliary signaling path.
IP FAS Path Properties Dialog Box
General Tab
MML Name Name of the component.
Description Description of the MML component.

External Node

External node.

Customer Group Table

Customer group table. This is a 4-digit index used in the Customer
Group table.

Customer Group ID

ID of the customer associated with the selected trunk group.

Call Ref Length

Call reference length.

Side Q.931 call model side.

MDO Message definition object file protocol name.
Details Tab

A/B Flag A/B flag.

ASP Part Auxiliary signaling path.

Admin State

Administrative state of the component.

Destination State

Point-code state.

Locked Number of bearer channels in LOCKED state.
Unlocked Number of bearer channels in UNLOCKED state.
Shutdown Number of bearer channels in SHUTDOWN state.

MGCP Path Properties Dialog Box and SGCP Path Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

External Node

External node.

NAS Path Properties Dialog Box
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Table 8-6 Properties of Signaling Path Components (continued)
Property Description
General Tab

MML Name Name of the component.

Description Description of the MML component.

External Node

External node.

MDO

Message definition object file protocol name.

Customer Group ID

ID of the customer associated with the selected trunk group.

Signal Slot

Physical slot on the NAS defining the NFAS Group (optional).

Signal Port

Physical port on the slot of NAS defining the NFAS Group (optional).

Details Tab

Admin State

Administrative state of the component.

Destination State

Point-code state.

Locked

Number of bearer channels in LOCKED state.

Unlocked

Number of bearer channels in UNLOCKED state.

Shutdown

Number of bearer channels in SHUTDOWN state.

Session Set Properties Dialog

Box

General Tab

MML Name

Name of the component.

Description

Description of the MML component.

External Node

External node.

First IP Address

First logical IP address.

Second IP Address

Second logical IP address.

First Peer Address

Remote IP address 1.

Second Peer Address

Remote IP address 2.

Ext Node Type

Session set external node type.

IP Route 1 Name of first IP route.
IP Route 2 Name of second IP route.
Details Tab
Port Local port number of link interface on the
Cisco PGW 2200 Softswitch host.
Peer Port Port number of the link interface on the remote device.

Network Mask Address 1

Network mask (not supported after Cisco PGW 2200 Softswitch
Release 9.3(2)).

Next Hop Address 1

Next hop (not supported after Cisco PGW 2200 Softswitch Release
9.3(2)).

Network Mask Address 2

Network mask (not supported after Cisco PGW 2200 Softswitch
Release 9.3(2)).
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Properties of Signaling Path Components (continued)

Property

Description

Next Hop Address 2

Next hop (not supported after Cisco PGW 2200 Softswitch Release
9.3(2)).

SIP Path Properties Dialog Box

MML Name Name of the component

Description Description of the MML component.

MDO Message definition object file protocol name.
Admin State Administrative state of the component.

Locked Number of bearer channels in LOCKED state.
Unlocked Number of bearer channels in UNLOCKED state.
Shutdown Number of bearer channels in SHUTDOWN state.

SS7 Path Properties Dialog Box

General Tab

MML Name

Name of the component.

Description

Description of the MML component.

Customer Group ID

ID of the customer associated with the selected trunk group.

Customer Group Table

Customer group table.

ASP Part

Auxiliary signaling path.

MDO Message definition object file protocol name.
Side Q.931 call model side.
OPC Originating point code.
DPC Destination point code.
M3UAKey MML name of M3UAKEY.
Details Tab

Admin State

Administrative state of the component.

Destination State

Point-code state.

Locked

Number of bearer channels in LOCKED state.

Unlocked

Number of bearer channels in UNLOCKED state.

Shutdown

Number of bearer channels in SHUTDOWN state.

SS7 Signaling Gateway Path Properties Dialog Box

General Tab

MML Name

Name of the component.

Description

Description of the MML component.

Customer Group ID

ID of the customer associated with the selected trunk group.

Customer Group Table

Customer group table.

ASP Part

Auxiliary signaling path.

MDO

Message definition object file protocol name.
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Table 8-6 Properties of Signaling Path Components (continued)
Property Description

Side Q.931 call model side.

OPC Originating point code.

DPC Destination point code.

Details Tab

Admin State

Administrative state of the component.

Locked Number of bearer channels in LOCKED state.
Unlocked Number of bearer channels in UNLOCKED state.
Shutdown Number of bearer channels in SHUTDOWN state.

Destination State

Point-code state.

TCAP Path Property Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

External Node

External node.

Label Properties Dialog Box

MML Name Name of the component.
Description Description of the MML component.
Call Limit Max number of calls allowed on this location label. O—n. Integer value

0 (default).

AXL Server Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

First IP Address

First local address.

Second IP Address

Second local address.

Port Local SCTP port number.

First Peer Address The highest priority destination address.

Peer Port Destination SCTP port number.

IP Route 1 MML name of the first IP route.

IP Route 2 MML name of the second IP route.

CTI Path CTI Sig Path component.

Version The version of CTI Path supported by Cisco PGW 2200 Softswitch.

CTI Path Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

External Node

MML name of a previously configured external node for this CTI

path.

CTI Manager Properties Dialog Box

MML Name

Name of the component.
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Table 8-6 Properties of Signaling Path Components (continued)
Property Description
Description Description of the MML component.

First IP Address

First local address.

Second IP Address

Second local address.

Port Local SCTP port number.

First Peer Address The highest priority destination address.

Peer Port MML name of the first IP route.

IP Route 1 MML name of the first IP route.

IP Route 2 MML name of the second IP route.

CTI Path CTI Sig Path component configured for this CTI Manager.
Version The version of CTI Manager supported by

Cisco PGW 2200 Softswitch.

H248 Path Properties Dialog Box (Added in Release 2.7(3) Patch 2)

MML Name

Name of the component

Description

Description of the MML component

External Node

External node.

Table 8-7 Properties of Signaling Link Components

Field Name

Description

C7 IP Link Properties Dialog Box

General Tab

MML Name Name of the component.

Description Description of the MML component.

IP Address IP address.

Interface Ethernet interface to which the link connects.

Priority Priority of the route.

Timeslot Time slot used by the link.

Details Tab

Port Local port number of the link interface on the
Cisco PGW 2200 Softswitch host.

Peer Address Remote IP address of link address.

SLC SS7 signaling link code.

Signal Channel State State of the signaling channel.

Network Mask Network mask.

Next Hop Next hop.

D Channel Properties Dialog Box

MML Name

Name of the component.
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Table 8-7 Properties of Signaling Link Components (continued)
Field Name Description
Description Description of the MML component.
Service Signaling service.
Status Operational status of the D-channel.
Priority Priority of the route.

Signal Slot

Physical slot on the gateway into which the T1/E1 is plugged.

Signal Port

Physical port on the gateway.

Session Set

Session set of backhaul link to the gateway.

TCP Link

Name of an existing TCP Link.

Sub Unit

Only for BRI D-Channel. Integer O or 1.

IP Link Properties Dialog Box

MML Name Name of the component.

Description Description of the MML component.

IP Address IP address.

Interface Ethernet interface to which the link connects (not supported after
Cisco PGW 2200 Softswitch Release 9.3(2)).

Service Signaling service.

Priority Priority of the route.

Port Local port number of link interface on the
Cisco PGW 2200 Softswitch host.

Peer Port Port number of the link interface on remote device.

Signal Slot

Physical slot on the gateway into which the T1/E1 is plugged.

Signal Port

Physical port on the gateway.

Signal Channel State

State of the signaling channel.

Network Mask Network mask (not supported after Cisco PGW 2200 Softswitch
Release 9.3(2)).

Next Hop Next hop (not supported after Cisco PGW 2200 Softswitch Release
9.3(2)).

IP Route IP route’s MML name.

State State of the IP route.

IP Route Properties Dialog Box

MML Name Name of the component.
Description Description of the MML component.
IP Address Local IP address.

Destination Destination hostname or IP address.

IP Route State

IP route state.

Priority

Priority of the route.

Network Mask

Subnet mask of destination (optional).

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Table 8-7 Properties of Signaling Link Components (continued)
Field Name Description
Next Hop Next hop router IP address.

Link Set Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

Protocol Family

Protocol used by the component.

APC

Adjacent point code for an STP.

Linkset Type

Type of transport for this linkset.

Linkset State

Service state of the link.

SIP Link Properties Dialog Box

General Tab
MML Name Name of the component.
Description Description of the MML component.
IP Address IP address.
Interface Ethernet interface to which the link connects (not supported after
Cisco PGW 2200 Softswitch Release 9.3(2)).
Priority Priority of the route.
Details Tab
Service Type of signaling service.
Port Local port number of the link interface on the

Cisco PGW 2200 Softswitch host.

Signal Channel State

State of the signaling channel.

Network Mask Network mask (not supported after Cisco PGW 2200 Softswitch
Release 9.3(2)).
Next Hop Next hop (not supported after Cisco PGW 2200 Softswitch Release

9.3(2)).

SS7 Signaling Gateway IP Link Properties Dialog Box

MML Name Name of the component.

Description Description of the MML component.

IP Address IP address.

Peer Address IP address of the remote peer.

Peer Port Port number of the link interface on the remote device.

Interface Ethernet interface to which the link connects (not supported after
Cisco PGW 2200 Softswitch Release 9.3(2)).

Priority Priority of the route.

SLC SS7 Signaling Link Code.

Signal Channel State

State of the signaling channel.

TDM Link Properties Dialog Box
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Table 8-7 Properties of Signaling Link Components (continued)
Field Name Description
MML Name Name of the component.
Description Description of the MML component.
Interface Ethernet interface to which the link connects.
Priority Priority of the route.
Timeslot Time slot used by the link.
Service Type of signaling service.
SLC SS7 signaling link code.

TCP Link Properties Dialog Box

MML Name Name of the component.

Description Description of the MML component.

IP Address IP address.

Type Signaling Type. BRI.

Port Local port number of link interface on the
Cisco PGW 2200 Softswitch host.

IP Route IP route's MML name.

External Node

External node.

Peer Port

Port number of the link interface on remote device.

Peer Address

Peer IP address.

Signal Channel State

State of the signaling channel.

Table 8-8 Properties of Signaling Point Code Components

Field Name Description

APC Properties Dialog Box
MML Name Name of the component.
Description Description of the MML component.
Network Address SS7 network address in dotted notation.

Network Indicator

Indicator assigned by the network administrator.

opC

Originating point code.

DPC

Destination point code.

Route Set State

State of the point code.

DPC Properties Dialog Box

General Tab

MML Name

Name of the component.

Description

Description of the MML component.

Network Address

SS7 network address in dotted notation.

Network Indicator

Indicator assigned by the network administrator.
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Table 8-8 Properties of Signaling Point Code Components (continued)
Field Name Description

OPC Originating point code.

DPC Destination point code.

Details Tab

Admin State

Administrative state of the component.

Route Set State

State of the point code.

Destination State

Point-code state.

Locked Number of bearer channels in LOCKED state.
Unlocked Number of bearer channels in UNLOCKED state.
Shutdown Number of bearer channels in SHUTDOWN state.

OPC Properties Dialog Box

MML Name Name of the component.
Description Description of the MML component.
Network Address SS7 network address in dotted notation.

Network Indicator

Indicator assigned by the network administrator.

OPC Type

Originating point code type.

Table 8-9

Properties of Signaling External Node Components

Field Name

Description

External Node Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

Extnode Type

Type of the external node.

Admin State

Administrative state of the component.

Locked Number of bearer channels in LOCKED state.
Unlocked Number of bearer channels in UNLOCKED state.
Shutdown Number of bearer channels in SHUTDOWN state.

M3UA/SUA Group
Number

M3UA/SUA group number.

ISDN Signaling Type

ISDN signaling type (optional).

SGP Properties Dialog Box

MML Name

Name of the component.

Description

Description of the MML component.

External Node

External node’s MML name.

SGP State

State of the Signaling Gateway Process.
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Table 8-10

Properties of Signaling Interface Components

Field Name

Description

Card Interface Properties Dialog Box

MML Name Name of the component.

Description Description of the MML component.

Card Type Type of card or adapter.

Slot Location of card or adapter within host device.

Ethernet Interface Properties

Dialog Box

MML Name Name of the component.
Description Description of the MML component.
Card Card that supports the interface.
TDM Interface Properties Dialog Box
General Tab
MML Name Name of the component.
Description Description of the MML component.
Card Card that supports the interface.
Signal Type Signal type.
Coding Line coding.
Format Interface format.

Details Tab

Line Interface Number

Line interface number.

Resistance Resistance.

Data Rate Data rate.

Clock Clock.

HDLC High-level data link control.

DTE/DCE Data terminal equipment/Data communications equipment.
Table 8-11 Properties of Signaling SS7 Components

Field Name

Description

SS7 Route Properties Dialog Box

MML Name Name of the component.

Description Description of the MML component.
Link Set Link set that leads to destination device.
Priority Priority of the route.

OPC Originating point code.

DPC Destination point code.

SS7 Subsystem Properties Dialog Box

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Table 8-11 Properties of Signaling SS7 Components (continued)
Field Name Description
MML Name Name of the component.
Description Description of the MML component.
Subsystem Number Subsystem number.
Priority Priority of the route.
Service Type of signaling service.
Protocol Family Protocol used by the component.
Transport Protocol Transport protocol.
Mated APC Adjacent point code for an STP mate.
STP/SCP Index STP/Service control point index.
SuaKey MML name of SUAKEY.

Local Subsystem Number |Local subsystem number (beginning in Release 9.5(2), used instead of
Subsystem number).

Remote Subsystem Remote subsystem number.
Number
OPC Origination point code.

SS7 Signaling Gateway Subsystem Properties Dialog Box
MML Name Name of the component.
Description Description of the MML component.
Subsystem Number Subsystem number.

Priority Priority of the route.

Protocol Family Protocol used by the component.
OPC Originating point code.

APC Adjacent point code for an STP.

STP/SCP Index STP/Service control point index.

Table 8-12 Properties of Signaling M3UA/SUA Components

Field Name Description

M3UA Key Properties Dialog Box
MML Name Routing key name. An alphanumeric string up to 20 characters.
Description Description of the MML component, up to 128 characters.
Service Indicator (Optional) Service indicator: ISUP,TUP,N/A. Default: N/A.
Routing Context Routing context value. Any integer except 0. Default: 0.
DPC (Optional) Destination point code.
Network Appearance (Optional) Network appearance. 0-32767. 0 indicates an invalid

network appearance. Default: 0.

OPC (Required) Originating point code.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
[ oL-14480-06 .m



Chapter8  Other Network Management Tasks |

M Viewing Properties for Devices and Their Components

Table 8-12

Properties of Signaling M3UA/SUA Components (continued)

Field Name

Description

M3UA Route Properties Dialog Box

MML Name M3UA route name. An alphanumeric string up to 20 characters.
Description Description of the MML component, up to 128 characters.
DPC MML name of previously defined destination point code.

Pri Priority.

External Node MML name of a previously configured external node.

OPC MML name of a previously configured origination point code.

SUA Key Properties Dialog Box

MML Name Routing key name. An alphanumeric string up to 20 characters.
Description Description of the MML component, up to 128 characters.
OPC (Required) Origination point code.

APC (Optional) Adjacent point code.

Local SSN Local subsystem number.

Routing Context

Routing context value, any integer except 0. Default: 0.

Network Appearance

(Optional) Network appearance. 0-32767. 0 indicates an invalid
network appearance. Default: 0.

SUA Route Properties Dialog

Box

MML Name SUA route name. An alphanumeric string up to 20 characters.

Description Description of the MML component, up to 128 characters.

APC MML name of previously defined adjacent point code.

External Node MML name of a previously configured external node.

Remote SSN Remote subsystem number (destination).

OPC MML name of a previously configured origination point code.
Table 8-13 Properties of IPInMapping Components

Field Name

Description

IpInMapping Properties Dialog Box

MML Name MML name of this IpInMapping.

Description Description of the MML component.

Sigsve Signaling services in which this IpInMapping is applied, SIP sigpath
or EISUP sigpath.

Allowed IP Address Allowed IP address. Host name or IP address with format x.x.x.x,

where x is 0-255.

Allowed IP NetMask

Allowed net mask. The format is x.x.x.x, where x is 0-255. The
default is 255.255.255.255.
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Table 8-13 Properties of IPInMapping Components

Field Name Description

Port Allowed SIP Port. Effective only for SIP sigpath.

Trunk Group Number Trunk group number using the signaling services specified in Sigsvc
(SIP or EISUP).

Viewing Trunk Group Component Properties

You can view the properties of trunk group components of a Cisco PGW 2200 Softswitch node such as
¢ Configuration
e Status
e SIP attributes (Cisco PGW 2200 Softswitch Release 9 and later)

Use the following procedure to view trunk group component properties:

Step1  In the Map Viewer window, do one of the following:

e To view information for all trunk group components, right-click the Trunking folder, and choose
Trunk Group Properties.

e To view information for a particular trunk group component, under the Trunking folder, right-click
the desired component and choose Trunk Group Properties.

The dialog box displays information on the selected component’s properties. See the “About the
Trunk Group Properties Dialog Box™ section on page 8-47 for details.

Step2  (Optional) In the Properties dialog box, you can use the toolbar buttons or menu options to
e Print the information on the current tab.
¢ Close the dialog box.
e Toggle dynamic update mode off and on.
e Refresh the window to update the information when dynamic update mode is off.

e Acknowledge that you have seen dynamically updated changes.

About the Trunk Group Properties Dialog Box

The Properties dialog box for trunk group components contains a toolbar and the fields described in
Table 8-14. By default, the Properties dialog box is dynamically updated as device information changes.
You can use toolbar buttons to turn updating on or off, acknowledge that you have seen updated
information, and check for changes as desired when dynamic updating is off.

See the “Common Functionality in Properties Dialog Boxes” section on page 8-9 for more on dialog box
functionality.

Note  The trunk group properties you see and the tabs where they are located depend on the release of the
Cisco PGW 2200 Softswitch software you are using.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Table 8-14 Properties of Trunk Group Components

Field Name Description
General Tab

Trunk Group Number Unique number (up to seven digits) assigned to each trunk
group that is used by route analysis. (The string “tg-" is
prepended to this number to create the MML name of the
trunk group used in components.dat yielding an MML name
of no more than 10 characters.)

Trunk Type Identified the trunk transmission media.

Customer Group ID ID of the customer group associated with the selected trunk
group.

Priority Priority of the route.

Select Sequence Selection sequence.

Service Type of signaling service.

Queuable Indicates whether the trunk group can queue calls.

Package Type CAS trunk group package.

Glare Call collision handling.

Default Presentation Number NOA |Sets the default for Presentation Number NOA value.

Default Presentation Number NPI |Sets the default for Presentation Number NPI value.

Default PN Enables the incoming trunk group to have a default
presentation number if the incoming call does not have one;
overdecadic digits are supported.

Maximum ACL Maximum congestion level.

Number Plan Area The numbering plan area (NPA) code associated with the
incoming trunk group.

Carrier ID The carrier ID to which users on this trunk group are
associated.

Orig. Carrier ID Carrier ID digit string.

CLLI Common language location identifier.

Carrier Screening Whether to apply carrier selection and screening on the call.

Notify Setup Complete Whether to send notification when call setup completes.

Send Address to CGPN Determines if CLI digits should be sent in outgoing CgPN

parameter. Value is O (False) for don't include address digits
in CgPN param or 1 (True) for including address digits in
CgPN param; default is 1.

CGPN Presentation Restricted Determines if incoming Presentation Indication should be
overridden. Value is 0 (False) for leave as-is or 1 (True) for
set to presentation restricted; default is 0.

Enable IP Screening Enables the incoming trunk group to select dial plan based on
IP address, source ID and CLI prefix tables.

Default PN Presentation Indicator |Sets default Presentation Number Presentation Indicator
value.
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Table 8-14 Properties of Trunk Group Components (continued)

Field Name

Description

O Min Digits

Added in Release 2.7(3) Patch 3. This property specifies the
minimum number of digits to receive for overlap digit
processing for call origination from this traffic path (integer,
from O to 32). Default value: 0.

O Max Digits

Added in Release 2.7(3) Patch 3. This property specifies the
maximum number of digits to receive for overlap digit
processing for call origination from this traffic path (integer,
from 1 to 32). Default value: 24.

O Overlap

Added in Release 2.7(3) Patch 3. This property indicates
whether overlap signaling for call origination from this traffic
path is enabled (1=enabled, O=not enabled). Default value: 0.

Overlap Digit Time

Added in Release 2.7(3) Patch 3. This property specifies the
waiting period for the rest of the digits (integer, from 0 to 60).
Default value: 6.

T Max Digits

Added in Release 2.7(3) Patch 3. This property specifies the
maximum number of digits to receive for overlap digit
processing for call termination to this traffic path (integer,
from 1 to 32). Default value: 24.

T Min Digits

Added in Release 2.7(3) Patch 3. This property specifies the
minimum number of digits to receive for overlap digit
processing for call termination to this traffic path (integer,
from O to 32). Default value: 0.

T Overlap

Added in Release 2.7(3) Patch 3. This property indicates
whether overlap signaling for call termination to this traffic
path is enabled (1=enabled, 0 = not enabled). Default value:
0.

Configuration Tab

Fax/Modem Tone

Specifies if notification of the fax/modem tone from the
Cisco PGW 2200 Softswitch is desired. Values are 0 (no) and

1 (yes).

Screen Fail Action

Indicates if an action is to be performed when a screening
failure occurs. Values and 0 (no) and 1 (yes).

Ring-No-Answer

Time (in seconds) during which ringing can occur.

AOC Enabled

Whether advice of charge handling should be applied to this
call. Values: 0 (no) and 1 (yes).

Echo Cancel

Whether echo cancellation is required. Values and 0 (no) and
1 (yes).

ACC Control

ACC control procedure flag.

D Channel Status

Host controller-MIB accRespCatName.

External COT

External continuity test indicator.

Support 183 Response Code

Flag indicating support of 183 response code.

| oL-14480-06
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Table 8-14

Properties of Trunk Group Components (continued)

Field Name

Description

Customer VPN ID

Assigns a VPN ID to a trunk group or system. Valid values:
1 through 8 numeric character string.

Default value: 00000000.

VPN On-Net Table Number

Assigns a VPN ON NET profile table index for a particular
trunk group.

VPN Off-Net Table Number

Assigns a VPN OFF NET profile table index for a particular
trunk group.

Populate SDP Info in CDR

Enables extraction of information from SDP. 1 enables, 0
disables. Default 0.

Support 100 Response Code

Flag indicating support of 100 response code.

ACL Duration

Duration (in seconds) that ACL remains in effect.

Satellite

Indicates if the trunk group is going over a satellite. Values
are 0 (no) and 1 (yes).

Call Orig. Index

Starting number analysis digit index for call origination.

Call Term. Index

Starting number analysis digit index for call termination.

Transparency Disabled

Indicates if ISDN User Part (ISUP) transparency is disabled.
Values: 0 (no) and 1 (yes).

COT Percentage

Statistical continuity test percentage.

Compression Type

The G.711 compression type used on the trunk.

From

The display name of the calling party.

Call Forward Reroute Disabled

Disables Call Forward rerouting for all calls. Range 0-1.
Default: 0.

Feature Transparency Disabled

Disables Feature Transparency for all calls. Range 0—1.
Default: 0.

OD 32 Digit Support

Indicates whether overdecadic and 32 digits are supported for
ANSI, Q721, Q761, and Q767 protocol variants. Values are 0
(no) and 1 (yes). Default: 0.

RejectOfferForResourcePending

Added in Release 2.7(3) Patch 4. Enable the
Cisco PGW 2200 Softswitch to either reject or buffer new
offer when resource is temporarily unavailable.

Status Tab
Admin State Administrative state of the component.
Locked Number of bearer channels in LOCKED state.
Unlocked Number of bearer channels in UNLOCKED state.
Shutdown Number of bearer channels in SHUTDOWN state.
SIP Tab
Local Port UDP port for SIP communication.
VSC SIP Version Supported SIP version.
VSC Domain Cisco PGW 2200 Softswitch domain name in SIP messages.
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Properties of Trunk Group Components (continued)

Field Name

Description

Max Redirection

The maximum number of SIP message redirects allowed.

Max SIP Forward

The maximum number of SIP forwards allowed.

T1 Timer T1 timer (in milliseconds) for SIP messages other than
INVITE messages.
INVITE Timer T1 timer for INVITE messages.

Invite Attempts

The transmission times for INVITE requests. Valid values are
1-15. Default: 7.

Non Invite Req Attempts

The transmission times for Non-INVITE requests. Valid
values are 1-15. Default, 11.

Response Attempts

The transmission times for response. Valid values are 1-15.
Default: 11.

Retrans Method

The re-transmission method. 1—exponential. 2—Ilinear.
Default: 1.

Invite Wait Timer

The timer (in milliseconds) of waiting for final response of
INVITE request. Valid values are 10000—500000. Default:
200000.

Orig. Session Timer

The maximum session time (in milliseconds) for a SIP call
originated by the Cisco PGW 2200 Softswitch.

Hold Timer

Maximum hold time for a SIP call.

MIN Event Subscribe Duration

Minimum duration for which an event can be subscribed, in
millisecond. Range: 40-3600 ms.

MAX Subscription Duration

Maximum duration for which the subscription can exist
before it needs a resubscription, in millisecond. Range:
0-3600 ms.

ISUP Trans Early Backward
Disabled

Disable sending the early backward message—183 session
progress without the SDP MIME body. 0—Enable,
1—Disable. Default: 1.

SIP MIME Body Support

Determines SIP-T and SIP-GTD related special processing of
data (used by SS7 and SIP trunk groups). 0—None, 1—SIP-T
supported, 2—SIP-GTD supported. Default: 0.

MGC SIP Version

The version of SIP protocol supported by
Cisco PGW 2200 Softswitch. Maps to trunk group property
MGCSipVersion. Any valid SIP version. Default: SIP2.0.

MGC Domain

Cisco PGW 2200 Softswitch's domain name used in SIP
messages. Maps to trunk group property MGCDomain. Any
valid domain name or NULL string.

Max SIP Forward

The maximum number of SIP forward allowed. Maps to trunk
group property MaxForwards. Any value > 0, default 10.

T2 Timer

T2 timer (in milliseconds) for SIP messages other than
INVITE messages.

EXPIRE Timer

Timer value (in milliseconds) in the EXPIRE header of SIP
messages.
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Table 8-14 Properties of Trunk Group Components (continued)

Field Name

Description

Term. Session Timer

The maximum session time (in milliseconds) for a SIP call
terminated by the Cisco PGW 2200 Softswitch.

Retry Timer

The time (in milliseconds) that Cisco PGW 2200 Softswitch
waits before retrying SIP calls.

GTD Cap Type

Used as a pointer to the subset of GTD configuration
parameters. Values: 0 - No GTD parameter string. Any other
string - points to entry in gtdParam.dat file. Default: 0.

Subscribe Notify Support

Enables or disables Unsolicited Notify method for solicited
notification of SIP DTMF digits.

GTD Message Format

Selects GTD message format. C - Compact mode, V - verbose
mode. Default C.

Unsolicited Notify Method

Enables or disables Subscribe/Notify method for solicited
notification of SIP DTMF digits.

SIP IP Source

Tells MDL to use IP packet source address or IP address from
SDP in INVITE message to do dial plan selection for SIP
calls.

SIP Egress Routing Control

Added in Release 2.7(3) Patch 2. The preferred SIP header
used for the initial routing decisions during sending of the
Initial INVITE

SIP-II Tab

SIP Ingress Routing Control

Added in Release 2.7(3) Patch 2. The preferred SIP header
used for the initial routing decisions (Initial INVITE)

Respect SIP URI User Parm

Added in Release 2.7(3) Patch 2. Determines whether or not
respect user=phone in p-asserted-id and remote-party-id
header. Values: 0 (no) or 1 (yes)

Map CLI to SIP Header

Added in Release 2.7(3) Patch 2. Determines the mapping
rule from calling line identity to SIP Headers. Values:
0,1,2,3,4

Sip Dtmf Content Type

Added in Release 2.7(3) Patch 4. Determines the
Content-Type header and the SDP content of INFO requests
Cisco PGW 2200 Softswitch sends.

Valid values:

e (0—Sets the Content-Type header to
audio/telephone-event

e |—Sets the Content-Type header to
application/dtmf-relay

Default value: 0

Refer Redirecting Indicator

Added in Release 2.7(3) Patch 4. Redirecting indicator of
Redirection Information in ITU SS7 REL message for blind
transfer by SIP REFER. Value range: 0-6.

Refer Redirecting NOA

Added in Release 2.7(3) Patch 4. NOA value of redirection
number in ITU SS7 REL message for blind transfer by sip
REFER. Use internal NOA value. Value range: 1-5.
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Properties of Trunk Group Components (continued)

Field Name

Description

Profile Tab

Originating Line Information

Default originating line information.

Carrier Network 1D

Default carrier identifier network identifier.

Carrier Network Type

Default carrier identifier national network type.

Carrier Network ID Plan

Default carrier network national network identifier plan.

Charge Number Default charge number.
Charge Number NOA Default charge number nature of address.
Charge Number NPI Default charge number plan identification.

Charge Origin

Specifies the charge origin. It is up to the network engineer to
decide what value of charge origin will be used. Value is 0 to
9999; default is 0.

Directory Number Presentation

Default directory presentation indicator.

Directory Number Screening

Default directory screening indicator.

Directory Number

Default directory number.

Directory Number NOA

Default directory number nature of address.

Directory Number NPI

Default directory number plan identification.

H.323 Tab

Gateway Ring Back Tone

Indicates if the gateway ring back tone application is
supported within the gateway that hosts the trunk group and
the connection method that is applied.

Wait for Answer Timer

Duration, in seconds, that the Cisco PGW 2200 Softswitch
waits to receive the Answer message after instructing the
MGW to apply ring back tone.

Wait for Originating SDP Timer

Duration, in seconds, that the Cisco PGW 2200 Softswitch
waits for the originating SDP information after transiting the
answer message.

Wait for Terminating SDP Time

Duration, in seconds, that the Cisco PGW 2200 Softswitch
waits for the terminating SDP information after transiting the
answer message.

Allow H.323 Hairpin

Whether to allow the HSI component connected through the
EISUP path to make and receive H.323 calls to and from
another HSI component.

Fax Support

What fax support, if any, is available on the incoming trunk
group.

H.323 Adjunct Link

Identifies an EISUP link that is connected to an H.323
adjunct platform.

H323Destination

HSI 323 Destination.

Characteristics Tab

A Number National Prefix

National prefix string to be added to the national dialed
number when NOA is enabled.
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Table 8-14

Properties of Trunk Group Components (continued)

Field Name

Description

A Number International Prefix

International prefix string to be added to the international
dialed number when NOA is enabled.

B Number National Prefix

National prefix string to be added to the national dialed
number when NOA is enabled.

B Number International Prefix

International prefix string to be added to the international
dialed number when NOA is enabled.

Apply Country Code to A Number

Whether to apply the country code to A numbers.

Apply Country Code to B Number

Whether to apply the country code to B numbers.

Country Code to be Removed

Country code string to be removed.

Country Code to be Prefixed

Country code string to be prepended.

A-number Normalization

(European feature; ingress trunk groups) Indicates that
A-number (Calling Party Number) normalization is
appropriate based on the NOA value and the leading digits of
the A-number. Leading digits 0: Remove 0 and set NOA to
NATIONAL. 00: Remove 00 and set NOA to
INTERNATIONAL.

B-Number Normalization

(European feature; ingress trunk groups) Indicates that
B-number (Called Party Number) normalization is
appropriate based on the NOA value and the leading digits of
the B-number. Leading digits 0: Remove 0 and set NOA to
NATIONAL. 00: Remove 00 and set NOA to
INTERNATIONAL.

SCP Credit Expired Timer

Time period before credit expiry that the SCP is notified.

SSF Credit Expired Timer

Time period before credit expiry that the SSF is notified.

Warning Credit Expired Timer

Time period before credit expiry that a warning tone or
announcement is played.

Expiry Warning Tone Type

Type of warning tone.

Expiry Warning Tone Duration

Duration of warning tone.

CLI Select Whether the Dual CLI feature is supported (default is N).
GW Default Codec String Ordered series of codec choices, separated by semicolons.
AdigitCCrm A-Number Country Code Digit Remove Property.

DPNSS RO Routing Number Added in Release 2.7(3) Patch 2. For DPNSS - QSIG PR
Length ROO inter-working, the DPNSS RO routing number and call

reference are concatenated and in QSIG they are separate
fields. An indication of where the divide point is between the
fields is an optional parameter in the DPNSS spec. It is
therefore necessary to provide a configurable definition of
how to split these two fields.

Enable CCBS Path Reservation

Added in Release 2.7(3) Patch 2. Support for the Path
Reservation option should be configurable against each QSIG
destination. In the case of EISUP, this is valid for HSI
destinations only.
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Table 8-14 Properties of Trunk Group Components (continued)
Field Name Description
Own Routing Number Added in Release 2.7(3) Patch 2. To disable/enable RO

service handling at point of interconnect. Value: NULL or a
numeric string

H248 Gateway Reserve Value Added in Release 2.7(3) Patch 2. Enable Megaco to send
ADD commands with ReserveValue ON or OFF to indicate
MG to reverse resource or not. Removed in Release 2.7(3)
Patch 5.

Disable QSIG Release Method Added in Release 2.7(3) Patch 3. This property indicates the
QSIG release method. An H.225 signaling connection can be
released with a single Release Complete message instead of
a three-stage QSIG release sequence.

UseGtdCalledPartyNumber Added in Release 2.7(3) Patch 5. Enables the

Cisco PGW 2200 Softswitch to use embedded
calledPartyNumber field of GTD in the invite message
instead of URL/number contained in the request line. Values:
0—disable, 1—enable.

More Tab

GW Default ATM Profile Provides an initial list of profiles for use in ATM gateway
profiles negotiation per trunkgroup. Default “NULL”
type="string” size min="1"" max="140".

Play Announcement Contains announcement id. 0 means the functionality will be
considered as switched off at the trunk group level. Default
GLO?’ type:’,int”‘

ATM Connection Type Populates connection type indicator (ct:) in local connection
option parameters. This property is read for both originating
and terminating legs of all ATM switched calls. Property
Valid Values: 1-->AAL1,2--> AAL1_SDT, 3-->AAL1_UDT,
4-->AAL2, 5-->AAL 3/4, 6-->AALS. default="4"
type="int” range min="1" max="6".

B-number Tech Prefix This property will provide a digit string to be used as a Tech
Prefix to the B-number when sending the call
forward.type=""string” size min="1" max="16".

Loop Avoidance Support This property will indicate whether to support Lop Avoidance
feature in DPNSS or not. Default 0 not supported, 1 -
supported.

Loop Avoidance Counter Loop Avoidance counter for DPNSS. Min value is 0 and Max
25. default 0.

Country Code to be Removed Country code string to be removed.

Country Code to be Prefixed Country code string to be prepended.

MWI String OFF MWI OFF string as used by DPNSS PBX, Default = NULL.

MWI String ON MWTI ON string as used by DPNSS PBX, Default = NULL.

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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Table 8-14

Properties of Trunk Group Components (continued)

Field Name

Description

Inhibit Incoming Calling Name
Display

This property inhibit the support of incoming calling name
display in DPNSS and EISUP(HSI) protocols. “1” = inhibit
incoming calling name display. “0” = enable incoming
calling name display.

Inhibit Outgoing Calling Name
Display

This property inhibit the support of outgoing calling name
display in DPNSS and EISUP HSI) protocols. “1” = inhibit
outgoing calling name display. “0” = enable outgoing calling
name display.

Inhibit Incoming Connected
Number Display

This property inhibit the support of the incoming connected
name display for call transfer in DPNSS and EISUP (HSI)
protocols. “1” = inhibit incoming connected name display.
“0” = enable incoming connected name display.

AOC Default Tariff Id

This property is used to configure the default tariff to be
applied when AOCInvokeType is configured as “All Calls”.
Min = “1”, max = “9999”. Default = “1”.

AOC Invoke Type

This property is used to configure whether the AOC
Supplementary services should be applicable for all calls or
for per call basis. (“1” = per call, “2” = All calls). Default =
‘6177.

Mid-Call Check Pointing Interval

A property to allow user to enable/disable mid-call
checkpointing and when enabled, it specifies the interval
between checkpointing event in the connected state. min = 0,
max=60(in minute unit). value zero means disabled.

CLI Selection For Code Of
Practice3

A new PGW2200 Trunk Group Property called
“CliSelectionForCodeOfPractice3” will be introduced in
order to provision “per Trunk Group” which level of CLI
selection should be employed when sending the Calling Line
Identities (such as Calling Party Number or Generic Number
parameter) to the succeeding exchange. O - Indicates no
specific CLI selection. 1 - Indicates Single CLI selection

2 - Indicates Dual (double) CLI selection Property Valid
Values: 0 to 2 Property Default Value: 0.

Inhibit Outgoing Connected Name

This property inhibit the support of the outgoing connected

Display name display for call transfer in DPNSS and EISUP (HSI)
protocols. “1” = inhibit outgoing connected name display.
“0” = enable outgoing connected name display.

Dtmf Cap The DTMF capability in A-number or B-number analysis.

Inhibit Outgoing Connected
Number Display

This property inhibit the support of the outgoing connected
number display for call transfer in DPNSS and EISUP (HSI)
protocols. “1” = inhibit outgoing connected number display.
“0” = enable outgoing connected number display.

Inhibit Sip From Mapping

Added in Release 2.7(3) Patch 2. Decides the mapping from
incoming SIP message to ISUP CLI

ITP Action Request

Added in Release 2.7(3) Patch 2. The indication of the
required ITP action
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Table 8-14 Properties of Trunk Group Components (continued)

Field Name Description

Map Redirecting Number Method |Added in Release 2.7(3) Patch 2. Decides the mapping from
ISUP Redirecting Number and Original Called Number to
outgoing SIP/EISUP message

Mid-Call Service Customer ID Added in Release 2.7(3) Patch 2. Customer ID associated
with mid-call service. Values are any alphanumeric with

length of 4.

Default Added in Release 2.7(3) Patch 3. Default trunk group of
SIP/EISUP PATH for incoming call

IsdnNSF Added in Release 2.7(3) Patch 5. Indicates Network Specific
Facilities parameter for ISDN PRI. Value range: 0-256.

MidCallCodecSelect Added in Release 2.7(3) Patch 5. Enables codec selection on

SIP Re-Invite message. Values: 0—disable, 1—enable.

Using Diagnostic Tools

Note

Step 1

When you need to troubleshoot Cisco PGW 2200 Softswitch node devices, you can use the Diagnostics
dialog box to access a variety of diagnostic tools. The Diagnostics dialog box provides shortcuts for
common diagnostics that normally require the use of UNIX or MML commands. For example, you can
use the ping command to determine why a device is not responding. It might be because of an SNMP
agent failure or because of a true network connectivity failure.

After the command is run, the results in the Action Result window displays. If the diagnostic command
generates more information than can be shown in the Action Result window, the results are written to a
file and the name of that file displays. The file can be retrieved and analyzed by external systems.

Many diagnostic commands are time consuming to run. Take this into account when planning your use
of diagnostic tools.

Related Topics

The “Using Cisco MNM to Launch Device Configuration” section on page 8-5 describes how to use
various configuration and diagnostic tools such as Cisco VSPT, CiscoView, and launching Telnet (or
ssh) or X-windows to a device.

The “Using the MGC Toolbar” section on page 8-60 describes how to use the MGC Toolbar, a diagnostic
component of the Cisco PGW 2200 Softswitch software.

Use the following procedure to run diagnostics on a Cisco PGW 2200 Softswitch node device:

In the Map Viewer window, right-click a device and choose [Device Name] Diagnostics or Tools >
[Device Name] Diagnostics.

The Diagnostics dialog box for the selected device opens.

S

Note  Alternatively, if you have an Accounts, Properties, States, or File Systems dialog box open for
the device, you can use the dialog box Navigation menu to open the Diagnostics dialog box.
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Step 2

Step 3

Step 4

Select a diagnostic option. For details, see the “About the Diagnostics Dialog Box™ section on page 8-58.
You are asked to confirm the operation.
Click Yes to confirm or No if you decide not to continue.

If you click Yes, An Action Report box displays containing the results of the diagnostic operation or the
name of the file to which the results have been saved.

Review the results, and then click Close to close the Action Report box.

About the Diagnostics Dialog Box

The Diagnostics dialog box lets you run common UNIX and MML diagnostic commands from
Cisco MNM without knowing any UNIX or MML or having to launch an X window to connect to the
device.

For the Cisco PGW 2200 Softswitch host and the Cisco HSI host, the dialog box contains two tabs: the
Diagnostics tab and the Advanced tab. The Advanced tab provides status check functions. For all other
devices, the dialog box contains the Diagnostics option only.

The Diagnostics dialog box includes a Navigation menu that allows you to navigate directly to
Properties, Accounts, File Systems (where applicable), or States dialog boxes for the selected
component, without having to reselect the component in the Map Viewer. See the “Navigating Between
Dialog Boxes for a Given Component” on page 32 for details.

Table 8-15 describes the diagnostic tools available from the General tab of the Diagnostics dialog box.
Table 8-16 describes the tools available for the Cisco PGW 2200 Softswitch host from its Diagnostics
dialog box Advanced tab. Table 8-17 describes the tools available for the HSI host from its Diagnostics
dialog box Advanced tab.

Table 8-15 Diagnostic Tools in the Diagnostics Dialog Box General Tab
Diagnostic Tool |Command Available Devices Description
IP Ping — Cisco PGW 2200 Sof |Performs standard UNIX ping application on
tswitch host, BAMS, |the device to check if its management interface
Cisco ITP-L, is reachable
Cisco LAN Switch
SNMP Ping — All IP devices Makes an SNMP request to the device to
determine if its SNMP agent is running and
accessible
Traceroute — All IP devices Determines the route that packets take from
Cisco MNM to the device’s management
interface
Alarm Log rtrv-alms Cisco PGW 2200 Sof |Displays and saves current alarm log
tswitch host, HSI information
server, and BAMS
Process Status |rtrv-softw:all |Cisco PGW 2200 Sof |Displays and saves current status of all device
tswitch host, HSI processes
server, and BAMS
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Table 8-15 Diagnostic Tools in the Diagnostics Dialog Box General Tab (continued)
Diagnostic Tool |Command Available Devices Description
System Log RTRV-FILE |BAMS Displays the BAMS system log
S::
/acec/files/sy
slog
Cross-Device  |prov-rtrv:tru |BAMS Compares BAMS trunk groups to the

Audit nkgrp Cisco PGW 2200 Softswitch host
configuration, producing a list of
discrepancies, if any

Table 8-16 Options in the MGC Host Diagnostics Dialog Box Advanced Tab

Option |MML Command’ Description

1 rtrv-admin-state Retrieves the administrative state for all (applicable) components

2 rtrv-dest Retrieves state information for all DPCs? and signaling paths

3 rtrv-Ink-ctr Retrieves the service state of all linksets

4 rtrv-1ssn Retrieves the state of all local SSNs

5 rtrv-ne-health Retrieves CPU occupancy and disk utilization

6 rtrv-rssn Retrieves the state of all remote SSNs®

7 rtrv-rte Retrieves the SS7 routes for all point codes

8 rtrv-sc Retrieves the state of all signaling channels and linksets

9 rtrv-tc Retrieves the state of bearers for all signaling paths

10 rtv-association Retrieves the state of all associations

11 rtrv-dest:all Retrieves the state of all DPNSS paths

12 rtrv-lics Retrieves the license status

13 rtrv-h248:cntxs:sigpat |Added in Release 2.7(3) Patch 2. Retrieves all the H.248 context

h="all”,cntxid="all” information

14 rtrv-ovld Added in Release 2.7(3) Patch 2. Retrieves information on overload

level and number of messages in a queue

15 rtrv-loclabel Added in Release 2.7(3) Patch 2. Retrieves location label information

1. The MML command invoked by the Status Check options, which runs in the background.

2. Destination point codes.

3. Subsystem numbers.

Table 8-17 Options in the HSI Host Diagnostics Dialog Box Advanced Tab
Option Description
Configuration Displays current configuration of the HSI host using the

rtrv-config command

HSI Link Status

Displays current status of the IP/EISUP links

| oL-14480-06
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Table 8-17 Options in the HSI Host Diagnostics Dialog Box Advanced Tab (continued)

Option Description

HSI Host Status Displays current status of the HSI host

HSI License Status Added in Release 2.7(3) Patch 2. Display current status of the
license

Using the MGC Toolbar

From Cisco MNM, you can access the MGC toolbar (see Figure 8-2), a standalone diagnostic component
of the Cisco PGW 2200 Softswitch software. The toolbar contains a suite of tools for viewing diagnostic
and troubleshooting information.

Figure 8-2 MGC Toolbar
¥ MGC Toolbar (O] x|
Alarmé& Meas CDR COMFIG-LIB Log Trace Translation File cose |2
Vievrer Viewer Viever Viewer Vievrer Verification Options o
=+

From the MGC Toolbar you can access these viewers:
e Alarm and Measurement Viewer—Search and view alarms and system statistics
e (Call Detail Record (CDR) Viewer—Search and view CDRs
e CONFIG-LIB Viewer—Manage the contents of the configuration library
e Log Viewer—Search and view system logs

e Trace Viewer—View and navigate through call trace output

Cisco Media Gateway Controller Node Manager User Guide, Release 2.7(3)
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e Translation Verification—View called number analysis results
e File Options—A tool to manage these toolkit files

Instructions for using the toolbar are provided in Chapter 3 of the Cisco Media Gateway Controller
Software Release 9 Operations, Maintenance, and Troubleshooting Guide at

http://www.cisco.com/en/US/docs/voice_ip_comm/pgw/9/maintenance/guide/omtguide.html
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